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Document Warranty

1. The information contained in this document is subject to change without prior notice.

2. The PNMS/PNMT screen images in this manual are only examples. Screens will vary
according to equipment configurations, equipment operation modes, setting parameters,
PNMS/PNMT application program version, etc. Screens contained in this manual are
current at the moment of publishing; however, they may differ slightly from the actual
screens on your PNMS/PNMT.

3. This manual is written on the assumption that you already understand the restrictions,
limitations and precautions necessary to operate the equipment properly. Refer to the
equipment manual for details.



11

1.2

ROI-S07052

Getting Started

Introduction

The PNMT is a computer-based PASOLINK Network Management Terminal system
developed by NEC for management of NEC’s PASOLINK wireless transmission network.
The PNMT is a scaled down version of PASOLINK Network Management System (PNMS)
that is designed as a maintenance tool for field engineers to locally and remotely monitor
alarms, control points, generate reports, and archive data, all within a familiar graphical user
interface, and all in real time. Throughout this manual, “the PNMT” generally refers to the
mobile laptop computer in which the NEC PNMT software package (that interfaces and
controls NEC PASOLINK series short haul wireless equipment) is installed.

This software package remotely monitors and controls the status and configuration of an
entire PASOLINK network with associated equipment as well as the performance of the
actual microwave radio links.

Conventions Used in This Manual

Font What the Font Represents Example

Italic For manual titles or related Please refer to PASOLINK

document names. Operation Manual for details.

Hostname Items on the user interface.

Bold Iltems on the computer display. | The Overall window

File and directory names.

[Button] Buttons in the user interface. Click [OK] button to continue
Click [Execute] button to send
command.

Menu Items A menu name followed by a Select System - Login/Logout

colon () means that you must
select the menu and then the
item.

When the item is followed by
an arrow (=), a cascading
menu follows.

A command variable where <password>
<username> | the user must make the
appropriate entry.

This is also commonly used
when asking for a password.

Keyboard keys. Press key.
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1.3 PNMT Communication Interfaces
131 Communications
Communications between the PNMT and the wireless network equipment is possible

e viathe LCT port of the equipment

1.3.2 LCT Port Interface

The LCT port is located on the front of the equipment.

I PASOLINK NEOQ ODU

| PASOLINK NEO HP IDU

LISB Cable
USB Port __

PNMT — IDU Connection

The PNMT and the Control (CTRL) Module mounted in the IDU must be connected using a
standard USB cable (the Type A plug is fitted into the Type A socket of the PNMT computer
and the Type B plug is fitted into the Type B socket of the LCT Port on the IDU Control
(CTRL) Module)

The LCT port has the following specifications:

e Connector type: USB Type B (female)

e Bit per second rate:  1200/2400/4800/9600/19200 (default 19200)
e Stop bits: 1

e Data bit length: 8

o Parity: no parity
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1.4 Equipment Configuration of PASOLINK NEO High Performance (HP)
PASOLINK NEO HP has 3 types of IDU.
e 1+0 (Terminal)
e 1+1 (Hot Stand-by)
e 1+1 (Twin Path)

(BLANK)

e oo @ puE

X0 P S 3P0 oW

©0,0'o o @B 5 SiEs

XIF 1 0F S WG G

1+1 (Hot Stand-by), 1+1 (Twin Path)

1.5 Hardware Requirements

Recommended configuration of PNMT mobile computer

e CPU: Pentium M 1.60GHz or equivalent
e RAM: 512MB or more

e HD: 40GB or more

e Display: color LCD (1,024 = 768) or more
e FD drive

e CD-ROM drive

e USB port

e Serial port (RS-232C)
e 10/100BASE-T (X) LAN port
e USB cable with USB-B connecter

¢ Internal sound system with speaker

1.6 Software Requirements

o OS: Windows XP Professional (English version) with SP2 or higher
Windows Vista Business Edition (English version) with SP1 or higher

e Acrobat Reader

e PNMT Application software
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2 System Operation & Maintenance

This chapter explains the menu structure and procedures for operating the PNMT. The
explanation uses typical PNMT screens to illustrate the hierarchy of menu.

2.1 The PNMT Screen
The PNMT window comprises the following main parts (Refer to Figure 1).

e Title Bar

The title bar of the window is used to indicate the title of the window.

¢ Common Menu Bar

The common menu bar of the window presents the System and Help options, illustrates the
commands that can be executed from the various options. The Help function also can
display operation manual.

e NE-specific Menu Bar

This menu is a list of tasks that can be performed to the specific network element (NE)
displayed in the PNMT. Configuration, Event Log, and Link Performance Monitor functions
can be executed in the NE-specific menu bar.

e Block Diagram

The block diagram illustrates the equipment/part of the PASOLINK wireless system. Its main
purpose in the window is to display the current summary alarm state of the equipment. You
can click a specific block to display the status of equipment in the Data Window.

e Overall Status Window

The Overall Status Window shows a snapshot of all important parameters/settings for the
NE. This window only displays current settings; control functions cannot be performed here.

e Data Window

This window displays in detail the status and alarm items of a specific equipment/part of the
NE. You can select the tab or the block of the specific equipment/part which you want to
monitor in the Data Window.

e Tabs

To view the status and alarms in the specific part of the NE, click on the tab at the bottom of
the Data Window.

¢ Command Button

The command button is used to enter the data selected in the pop-up window into the
computer.

e Text Box

This is a standard Windows dialog box where the user inputs the desired value.

e Login User

Denotes the user currently logged-in to the PNMT.

e Background color attribute for each alarm and status

The respective Background color for each alarm and status is as follows:
normal: Green, major alarm: Red, minor alarm: Pink,
status value: White, disabled: Gray, maintenance: Yellow
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=0
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| Selected Metwork Element ‘/ Opposite Metwark Element N E_S DECIfIC

B Configuration ME Stored Log & Performancehforitor < B Configuration NE Stored Log (¥ Performancedoritor ! Menu Bar

¥ \ .
Mo.001 [ PASOLIMK MNEOD HP ] : o 002 | PAEOLINK MEC HF |
Block
MODEM No.T_[MAINMVORK) | SUBFROT) Diag ram
ForoF, MODEM Mo.2 | CTRL
CAUKID [ MANT | EPM [ Inveniory | AT [ MAINT ([ EPM ][ Inventory |

= o

Catenory tterm Status Category ftem Status

amman TX RF Freguency :200.000[MHz] Cammon TX RF Freguency :200.000[MHZ]

omman RX RF Freguency 449 500[MHz] Cammon R} RF Freguency 449 500[MHz]

OrmImon TX Pover Control TPC Common TX Povwer Control ATPC

omman TPC T Poweer Q[dB] Zammon Frame IDt

OrmImon Frame IC 3 | [Comman PIC Usage Lized(Main Master)

{alyilyylalyt PIC Usage LzediMain Master) iZommon ainfiork) - INTFC{1) 1ZhE over STM-1/300ME

amman AinQYork) - IMTFCO1) STM-1(Optical) Cammaon SUBCPROT) - INTFC(2) WWSILANZ

{alyilyylalyt SUB(PROT) - IMTFC{2) ST Optical) iZommon Transthission Capacity < 00[ME]

OrmImon Transmission Capacty SE[ME] Common nclulstion Scheme 25EEAM

OMmmon odulation Scheme 28014M g

OrmImon ALS Function Lisabled

Omman APS Online Status Protection

OrmImon TH W Status 01

OMmmon FX SV Status o1
Ready (I 5 Admin

Login User
PHON Select
Moo
Het He2 — Text Box

R Level TCH Threshald 0.0| [dEm]

SES Activation Condition

2 15[36] @ E0[%)]

R Lewel TCH Threshold 0.0| [dEm]

e I——

| N || - |/

- Detail — No 001

—— Radio Button

—— Command Button

List
Data
i
= Window
Category ttem Status

Common CTRL Module ormal bl
Common hAC hount 01t
Common CTRL ol
Common FIC Mode Mismetch ol =

DatelTime

CFU Feset
DL Configuration File |
DL Program File
DL Eguipmert Config. File

e by Fle =
S—

CDLY | ODUZ | MODEM1 | MODEMZ | Mal FK) | SUB(PROT) | alxuo  crRe | Invertary

Tabs

Figure 1 Standard components of PNMT Window
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2.2 Launching the PNMT Application
To start PNMT:
1. Turn ON the computer.

NOTE

Connect the PNMT cable 30 seconds after IDU's power
is ON and make sure that the PNMT cable is connected
between USB port of the PNMT computer and the LCT
port of the IDU.

2. Login to Windows OS.
3. Click Start > Programs - PNMTj - Pnmt, then continue to the login window.

PNMT x]

MNEC
Please enter user name and password.
User name :
Pazsword :
riZonnection
i) Ethernet - Dialugp
Dialup Ertry Marne
PHMTIRS2320C)
PRMTILSE])

NOTE

Please do not change the clock settings of your
computer once PNMT has started.
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2.3 Login
Users are registered by means of login name and password.

To protect the network and network management system from unauthorized access or
unauthorized modifications, five levels (refer to the table shown in section 2.3.1 User Access
Privilege Levels) of users are defined with different privileges. The functions available in the
window depend on the user’s access level. Therefore, some of the functions may or may not
be carried out.

The highest or administrator level (Admin) has full access to the network and network
management system. :
EMMT rg|

To login: NEC
1. Start PNMT, and then Login window Please enter user name and password.
appears. Lser rame :

Passvward :

2. Enter the <user name>.

. Connection
3. En_t_er the valid <password> for the je— ® Dialup
specific user.
Dialup Entry Mame
H H PHITIRS252C)
4. For Connection select Dialup. e

5. For Dialup Entry Name select
PNMT(USB).

6. Click the [Login] button. If you wish to
exit the program, click [Exit] button.

Login | | Exit |

AEE

System  Refresh  Help

B

Selected Metwork Element " Opposite Metwaork Element
= Configurstion ME Stored Log & Performancemonitor = Configuration ME Stored Log & Performancemonitor
Mo.001 [ PAZOLIMK MED HP ] Mo.002 [ PASOLIMK MED HP |

Ao [ wANT [ TPM ][ Inventory | | [CAETS [ MANT [ CPM | [ Imventory |

Category ftem Status Category ftem Status
Oman T RF Freguency 500 .000[MHzZ] | Common T RF Freguency 500.000[MHzZ]
OMIMon R% RF Freguency 449 500[MHz] Comimon RX RF Freguency 449 500[MHz]
ammon T¥ Povwer Control ATPC Common T¥ Povwer Control ATPC
oMo Frame IO Common Frame [0t
man PIC U=zage Lzed(Main Master) Common PIC Lzage Lzed(Main Master)
OMIMan sinfiork] - IMTFC1) GhE over STM-1/300ME Comimon sinWork] - IMTFC1) GhE over STM-1/300MEB
armman SUB(PROT) - INTFC2) WSILANZ Zommaon SUB(PROT) - INTFC2) WWSILANZ
OffmMon Tranzmis=ion Capacity A00[ME] Zommon Transtission Capacity A00[ME]
QMmon odulstion Scheme 2EECIAM Common odulstion Scheme DSECIAM
Ready ( 5 Admin
Login“User
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23.1 User Access Privilege Levels

v: Available, -: Not available

Functions User Name and Accessible Functions
Category ITEM Monitor | User | Local | Remote | Admin
SYSTEM ALARM BUZZER - v v v v
CONNECT (Remote Login) - - - v v
NE LIST CONNECT - - v v
NE STORD LOG SAVE AS - v v v v
EQUIPMENT (Wizard Setting) B - v 7 7
SETUP NE NAME - - v v v
NOTE - v v v v
PROVISIONING CHANNEL SETTING MS-AIS GENERATION - - v v v
STM-1 USAGE - - v v v
RSOH CH SELECT - - v v v
BER THRESHOLD HIGH BER THRESHOLD - - v v v
SETTING LOW BER THRESHOLD - - v v v
E-BER (DMR) - - v v v
SD (DMR) - - v v v
E-BER(MUX) - - v v v
SD (MUX) - - v v v
SUB INTFC E1 WS USAGE - - v v v
WS IMPEDANCE v v v
WS AIS GENERATED REPORT - - v v v
WS AIS RECEIVED REPORT - - v v v
SC ASSIGNMENT RS-232C-1 - - v v v
RS-232C-2 - - v v v
V11-1 - - v v v
V11-2 - - v v v
SC LAN1 - - v v v
V11-1 DIRECTION SETTING - - v v v
V11-2 DIRECTION SETTING - - v v v

LAN PORT SETTING LAN PORTX(MAIN) USAGE

TX SW REVERSE FUNCTION - -
RX SW PRIORITY
RX SW MAINTENANCE MODE - -
RX SW CONDITION-EARLY WARNING - -

LAN PORTxX(SUB) USAGE - - v v v
SPEED & DUPLEX PORTX(MAIN)
SPEED & DUPLEX PORTX(SUB) - - v v v
FLOW CONTROL PORTX(MAIN)
FLOW CONTROL PORTX(SUB) - - v v v
COLLISION REPORT PORTxX(MAIN)
COLLISION REPORT PORTX(SUB) - - v v v
LINK LOSS FORWARDING
PORTX(MAIN)
LINK LOSS FORWARDING
PORTX(SUB) - - v v v
CLOCK SOURCE SETTING - - v v v
SUB SWITCHING FUNCTION - - v v v
GbE MEDIA TYPE - - v v v
GbE SPEED & DUPLEX - - v v v
GDbE LINK LOSS FORWARDING - - v v v
GbE FLOW CONTROL SETTING - - v v v
ALS ALS FUNCTION - . v v v
ALS INTERVAL - - v v v
TX POWER CTRL MTPC TX POWER - - v v v
ATPC THRESHOLD LEVEL - - v v v
ADDITIONAL ATT - - v v v
ATPC RANGE (MAX) - - v v v
ATPC RANGE (MIN) - - v v v
ATPC POWER MODE - - v v v
COMM ALARM MODE - - v v v
CONDITION TX SW PRIORITY B - v v v
for TX/IRX SW TX SW LOCK IN USAGE - - v v v
v v v
v v v
v v v
v v v
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v': Available, -: Not available

Functions

User Name and Accessible Functions

Category

ITEM

Monitor

User

Local Remote | Admin

PROVISIONING
(Cont'd)

CONDITION for APS

APS MAINTENANCE MODE

v v v

APS CONDITION-SF

APS CONDITION-SIGNAL DEGRADE

LOCK IN USAGE

LOCK IN COUNT

LOCK IN DETECT TIME

LOCK IN HOLD TIME

RELAY

RELAY CONFIGURATION

CLUSTERL1 INPUT

CLUSTER2 INPUT

CLUSTERS INPUT

CLUSTER4 INPUT

TCN THRESHOLD

TCN THRESHOLD(PMON Threshold)

XPIC CONDITION-
LOCAL FAIL

XPIC CONDITION-LOCAL FAIL

EOW IF TYPE

EOW2 EXTERNAL SETTING

PMON SELECT

RX LEV TCN THRESHOLD

SES ACTIVATION CONDITION

ALARM CORRELATION

ALARM CORRELATION CAPABILITY

MAINTENANCE

MAINTENANCE

TX SW MANUAL CONTROL

RX SW MANUAL CONTROL

ATPC MANUAL CONTROL

ATPC MANUAL CONTROL POWER

TX MUTE CONTROL

TX MUTE OFF CONTROL TIME

CW CONTROL

APS MANUAL CONTROL

IF LOOPBACK

MAIN LOOPBACK-1 INTFC(1)

MAIN LOOPBACK-1 INTFC(2)

MAIN LOOPBACK-2

DADE ADJUST

LAN DEVICE RESET

ALS RESTART

XPIC CONTROL

RF SETTING SUB BAND

ANTENNA ALIGNMENT MODE

X-DEM DELAY ADJUST

AUX 1/O

INPUT

OUTPUT

CLUSTERx ALARM

PMON

PMON

ALL DATA CLEAR

SAVE AS

RMON

ALL DATA CLEAR

SAVE AS

AN RSN AN ANENEAN

CTRL

CONTROL

DATE/TIME

ANENEN AN RN N NN EANE S AYAYAYAYAYANENENE NN NN NN NN AN AN N NN N N RN ENENENENENENENENENEN RN
AN NN NN NN NN RN NN NN NN NN NN NN AN A AN YA RN NN NN RN ENENE NN NN

DOWNLOAD

CONFIGURATION FILE

PROGRAM FILE

EQUIPMENT CONFIG. FILE

SOFTWARE KEY.FILE

UPDATE

SOFTWARE KEY FILE

UPLOAD

CONFIGURATION FILE

EQUIPMENT CONFIG. FILE

SOFTWARE KEY.FILE

A RSN AN AN AN A AT AN A A A AN R AN Y A A A A AN A A A R A A A A A A A YA A YA Y AY N AN AN ENENENENENENENENENEN

CTRL(cont'd)

EQUIPMENT
NETWORK SETTING

NETWORK SETTING

AN

CPU RESET

RESET

AN
<
AN

-10 -




*Admin:

*Remote:

*Local:

*User:

*Monitor:

Enabled to access all Network Elements.

Enabled to access all Network Elements.
(Disabled from changing network configuration and changing/downloading programs)

Enabled to access directly connected Network Elements.
(Disabled from changing network configuration and changing/downloading programs)

Enabled only to access items which do not affect the equipment.

Enabled only to monitor (disabled from control).

-11-
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2.4 Shutting Down the PNMT
To close the PNMT application:

System | Refresh  Help

Change Pazsward..

Alarm Buzzer... o

Connect...

Exit

1. Click System - Exit in the menu bar of the PNMT main window.

2. Click [OK] button in the confirmation message window to close the application.

"

Do o weant to exit PMMT?

| 04 || Cancel |

-12-
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2.5 Searching for Network Elements and Connecting to Selected NE

The summary description (NE Name, Equipment Type, Opposite NE, etc.) of the current NE
where PNMT is connected can be displayed using this function. Summary description of the
opposite NE belonging to that link is also displayed.

To search for or connect to NE in the network:

1. Click System - Connect in menu bar of PNMT main window.

[ PNMT,

Swstem | Refrezh  Help

Change Password..

Alsrm Buzzer... r

Connect. ..

E:xit

S5 Network Element List E"E”g|
List

Metwark Element Mame Equipment Type Opposite Metwwork Element P Address
Mo 001 PaSOLIMK MEC HP 1+0 ro.002 172.017.254 253
| [ PASOLIMK MECQ HP 1+0 o 00 172.019.000.002

NOTE

Initially only the current NE physically connected to the
PNMT and its opposite NE will be shown in the Network
Element List.

2. Click on X icon in the tool bar or List = Search for Network Element in the menu
bar of the Network Element List window to display all connectable Network Elements in
the network.

3. Select and highlight the Network Element to be viewed.

(|

4. Click on 2 icon in the tool bar or List & Connect to Network Element in the menu
bar of the Network Element List window. The PNMT main window for both the
selected, and its opposite, Network Element will be displayed.

NOTE

Simultaneous connection from multiple PNMT to the
same NE is possible:
1 Local connection
PNMT is directly connected to the NE
2 Opposite connection
PNMT is connected to
opposite NE (of the local network)
3 Remote connection
PNMT is connected to the NE via remote access.
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2.6 Change Password

To change the password:

o &~ W DN

ROI-S07052

1. Click System - Change Password in the menu bar of PNMT main window.

Swstem | Refrezh  Help

Change Passwoard...

Alarm Buzzer...

Connect...

Exit

Old pazssward

Mewy passward

Confirm nesy passward |

ik,

Cancel

Enter the old <password>.

Enter the new <password>.

Re-enter the new <password> in the Confirm New Password box to confirm.

Click [OK] button.

For details on initial user name and password, please
refer to PNMT Installation Manual.

NOTE

-14 -



ROI-S07052

2.7 Alarm Buzzer Setting

This function is used to activate and set the Alarm Buzzer. The desired sound scheme can
also be set using this function.

To set the Alarm Buzzer:

6. Click System = Alarm Buzzer in the menu bar of PNMT main window.

Syatem | Refrezh  Help

Change Pazsword...

Alarm Buzzer ... r

Connect. ..

Exit

Alarm Buzzer

Alarm Buzzer

i) Mo sound

@ Wave file  |D-isample way || [. | g

| Ok || Cancel || Ay |

7. Select the Wave file to activate the buzzer. No sound is the factory setting of the
PNMT.

8. If you select the Wave file box, enter the location of the sound file (*.wav) Otherwise;
click the browse || button to locate the desired file. You can also preview the *.wav
file by clicking on the arrow __» | putton next to the browse button.

9. Click the [OK] button to activate the new setting.
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2.8 Refresh

This function is supported only by PNMT. This function enables PNMT to manually obtain
metering and alarm status, as well as to update equipment information.

To Refresh:

Click Refresh - Refresh in the menu bar or click on the refresh icon in the tool bar.

Refresh  Help
*

=] o

Systemn | Befresh | Help

S':.fster‘n_

of?
s

Refresh
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2.9 Remote Viewing using PNMT main window

You can view a target link underlying the one Root NE in the managed network by searching
the connectable NEs and then connecting to the target NE. Please refer to Section 2.5
Searching for Network Elements and Connecting to Selected NE. This feature allows
remote connection to any NE in the network.

System | Refresh Help

Change Passwoaord...

Alarm Buzzer ... o

Connect. ..

Exit

5 Network Element List

=JE3

List
Metwark Elemert Mame Equipment Type Opposite Metwork Element IP Address
[+ 00 PASOLINK MEC HP 1+0 o 002 172017 254 253
PASOLIMK MEC HP 140 o001 172.019.000.002

(=19

System  Refresh Help

EE
Selected Metwork Element : Opposite Metwoark Element
o Configurstion ME Stored Log & PertarmanceMonitar o Configuration ME Stored Log & Periormancemonitor
Mo.001 [ PASOLINK MES HP ] o002 [ PASCLIMK MEC HP ]
; ‘j oDy
G

WAINWORK) | SUBFROT) MANCAVORK) | SUBEROTY
CTRL __CTRL

PNMT main window (1+0 configuration)
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2.10 License
To protect PNMT functions, the PNMT application includes relevant license files.
To display the current license status:

10. Click Help = License in the main window.

Zystem Refresh Help|

e o Help ¥
Ahaout... r

Licensze...

License

Licenze Type Trial S
Period of Walidity 0111052009

11. Click [Close] to exit this screen. To change the license file, click [Import], and proceed
as follows.

12. Click [Next] to continue.
Import License E|

Welcome to the Import License

To continue, click Rext.

= Back Mext = H Cancel
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13. Specify the License.Key file if one is available. Click [Next].

X]

Import License

Select License File
Please zelect file (Default file name is "License key")

Licensze file :

O zample_license key | |:|

| = Back Mext = H Cancel

14. The progress of Check License File will be displayed. If no error is encountered when
importing license file, click [Next] as soon as the button becomes available.

Import License D_(|

Check License File
Logd and check the new License.
Thiz may take several seconds.

& Loading license file...
& Checking Limitz...

& Checking Key Code...

= Back Mext = H Cancel
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15. Confirm the type of license Imported, and click [Next].

Import License r)(|
Import License Limits
Fallowing limits wwere imported from file
Hewy “alue
Licenze Type Permit
| = Back | Mext = ” Cancel

16. Click [Finish] in ensuing window to end Import License Wizard.
Import License [E|

Import License has done

To processing is performed, click Finish.

= Back Finizh H Cancel
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2.11 Overall Status Window

This window is displayed during startup. The Overall Status Window provides a snapshot of
the most significant monitored items in the NE.

Categary ftetn Status
Camman Tx RF Fregquency S00.000[MHz]
Overall Status
Window Camman FX RF Fregquency 443 S00[MHz]
Comman TX Povwver Control ATPC
Comman Frame [T 1
Camman HPIC Usage Mot Used
Camman Main(ork) - INTFCE ) 2 ETh-1(Optical)
oo SUBPROT) - INTFC(2) 2xSTM-1(Optical)
Camman Tranzmizsion Capacity 1 SE[ME]
Comman Modulation Scheme 1250040
Comman ALS Function Dizahbled
Comman APS Cnline Status Protection
Comman TH S Status Mo
Comman Rl S Status Mo

The Overall Status Window shows a snapshot of all important parameters/settings for the NE.
This window only displays current settings; control functions cannot be performed here.

The following items are displayed in this window:

TX RF Frequency — the currently used transmission frequency **.
RX RF Frequency — the currently used receiving frequency. *

TX Power Control — shows the power control mode currently used by the ODU. The
TX Power Control is either Automatic Transmitter Power Control (ATPC) or Manual
Transmitter Power Control (MTPC).

MTPC TX Power — the value (in dB) of the Manual Transmitter Power Control
attenuation currently set in the ODU. The MTPC Attenuation will only have valid data
if the MTPC is enabled. **

Frame ID — the predefined value of the NE frame ID. **

XPIC Usage - the status of usage for the XPIC.

Main (work) — the main work interface setting.

SUB (PROT) — the SUB (PROTECTION) Interface setting
Transmission Capacity — the transmission capacity of the system.
Modulation scheme — the currently used modulation type.

ALS Function — Intermittently turns laser output on/off after designated interval from
start of LOS mode being "Enabled" or "Disabled" (Only STM-1 (optical) or 2xSTM-
1(Optical) interface)

APS Online Status — indicates route when APS is available.

TX SW status (for hot standby configuration only) — shows which modem-ODU
configuration is currently used for transmitting signals.

RX SW status (for 1+1 system only) — shows which modem-ODU configuration is
currently used for receiving signals.

" For Twin path configuration both respective parameters (1, 2) are shown

-21-



2.12 ODU Tab
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The ODU tab displays the status of the monitored ODU items. This window only displays
current settings and no control functions are available here.

To set the ODU parameters see the chapters on Equipment Setup and Provisioning.

To view the alarm/ status display of the ODU:

1. Click the respective ODU field in the PNMT main window of the target NE.

+- Detail — No_001

Category

Status

0.1

CDU Type Mismatch ormal

0.1 T Powver orimal
o1 T Imput ol
0.1 R Level ormial
o1 APC ol
0.1 QDU CPUMCahle Open orimal

0.1

ute Status Off

0.1 TCN-RX LEV-15min ormal

0.1 TCH-RX LEY-1day ot
Comman T S Status o1
Comman R S Status 0.1

cout | opuz | mopemt | mopemz | memcevork) | suseromy | auxuo | TR | mwentory |
T

Overview and description of the Items monitored in the ODU.

Iltem/Feature

Description

Specific conditions for it to
be displayed/configured

ODU Type Mismatch

Indicates that an invalid ODU is in use.

None

TX Power

Indicates the status of the transmitter in the ODU;
it is issued when the transmission level decreases 3
dB or more from the preset minimum ATPC level.

None

TX INPUT

Indicates the status of the ODU input signal from the
IDU; it is issued when the input signal from the IDU is
disrupted

None

ODU Linearizer

Indicates the status of the linearizer in the ODU; it is
issued when an anomaly occurs in the linearizer.

None

RX LEVEL

Indicates the status of the received RF signal level of
the ODU; it is issued when the RF signal drops below
the RX threshold.

None

APC

Indicates the status of the synthesizer in the ODU; it is
issued when an anomaly occurs in the synthesizer

None

ODU CPU/Cable Open

Indicates the status of the CPU in the ODU; it is issued
when an anomaly occurs during CPU operation

None

Mute Status

On: transmitter output is muted (off)
Off: transmitter output is normal (on)

None

LO REF

Indicates the status of the LO reference signal used for
V/H signal synchronization. When the reference signal
in the ODU falls below the threshold, this alarm is
issued.

for XPIC

TX SW Lock-in Status

Indicates the status of TX SW Lock-in Status

Only when TX SW Lock-in
Usage is "used"

TX SW Reverse
Request

Indicates the status of TX SW Reverse Request

Only when TX SW Reverse
Function is "used"
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ltem/Feature

Description

Specific conditions for it to
be displayed/configured

TCN-Rx LEV-15min

The (lower) Threshold Crossing Notice level for 15 min
alarm

None

TCN-Rx LEV-1day

The (lower) Threshold Crossing Notice level for 1 day
alarm

None

Tx SW Status

Indicates the modem-ODU configuration currently used
for transmitting signals

Only for 1 + 1 hot standby

Rx SW Status

Indicates the modem-ODU configuration currently used
for receiving signals

Only for 1 + 1 hot standby or
1+ 1 Twin path
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2.13 MODEM Tab
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The MODEM tab displays the status of the monitored items of the modem. This window only
displays current settings and no control functions are available here.

To set the modem parameters see the sections on Equipment Setup and Provisioning.

To view the alarms and status of the modem:

1. Click the respective MODEM field in the PNMT main window of the target NE.
CEX

7 Detail = No.001

=
Category ftem Status
0.1 ODEM Unequipped armal
o1 ODEM Type Mismatch ormal
0.1 ODEM Module ormal
0.1 LOF orthal
0.1 Frame D ormal
0.1 High BER ormal
0.1 Lo BER orrrial
0.1 Eatly Warning ormal
0.1 oD ormal
0.1 DEM ormal
0.1 nput Yoltage orrrial
0.1 Fower Supply ormal
0.1 F Cable Short ormal
0.1 Cable EGL ormal
0.1 IF ol
0.1 PIC Status armal
0.1 REF ormal
0.1 Linearizer Function Gk QPR
0.1 Linearizer ormal
0.1 ATPC Poweer hiode Active

[olulN}| | ODUZ  MOoDEMI

MODEMZ | MalewoRrk) | sUBPROT) | auxio | €TRL | mventory |

Overview and description of the alarm and status items/features of the modem

ltem/Feature

Description

Specific conditions for it to
be displayed/configured

MODEM Module

Indicates the status of the modulator-demodulator.
This alarm is issued when an anomaly occurs in the
modulator-demodulator.

None

signal deteriorates below the preset threshold level,
this alarm is issued and the RX-Hitless Switch is
operated. The selectable threshold levels are 1E-3,
1E-4 and 1E-5.

MODEM Unequipped | Indicates whether a MODEM is properly mounted. If None
the MODEM contact is unplugged or if none is
mounted (in accordance with the "Equipment Setup"),
this alarm is issued.

MODEM Type Indicates that an invalid modem is in use. None

Mismatch

LOF Indicates the frame synchronization status. If the None
synchronization with DMR is disrupted, this alarm is
issued.

Frame ID Indicates that the frame ID numbers of an NE and its None
opposite are out of sync.

High BER Indicates severe quality deterioration status. If the None
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Iltem/Feature Description Specific conditions for it to
be displayed/configured
Low BER Indicates low to moderate quality deterioration status None

between radio sections. When the signal deteriorates
below the present threshold value, this alarm is issued
and the RX-Hitless Switch is activated. The selectable
threshold values are: 1E-6, 1E-7, 1E-8 and 1E-9.

Early Warning

Indicates quality deterioration status. If the signal
deteriorates beyond the present threshold level, this
alarm is issued and the RX-Hitless Switch is activated.
The present threshold is a BER of 1E-9.

None

MOD

Indicates the operating status of the MOD. If any
anomaly occurs in the modulator, this alarm is issued.

None

DEM

Indicates the operating status of the DEM. If any
anomaly occurs in the demodulator, this alarm is
issued.

None

Input Voltage

Indicates the operating status of the input power
voltage. When there is an anomaly in the input voltage,
this alarm is issued.

None

Power Supply

Indicates the operating status of the power supply.
When there is an anomaly in the power supply, this
alarm is issued.

None

IF Cable Short

Indicates the status of IF cable between IDU and ODU.
If a short circuit is caused between ODU and the IDU,
this alarm is issued.

None

Cable EQL

Indicates the status of the IF cable equalizer. This
alarm is issued when the equalizer function does not
kick in.

None

XIF

Indicates the status of the XIF input signal of the Main
Master IDU and Sub Master IDU. When the XIF input
signal falls below the threshold, this alarm is issued
and the XPIC function is reset.

for XPIC

XPIC Status

Indicates the status of XPIC operation. When the XPIC
function is reset, “Reset” is indicated and the “Reset”
LED on the front panel is lit.

for XPIC

XREF

Indicates the status of the CLK reference signal used
for V/H signal synchronization. When there is an
anomaly in the reference OSC in the MODEM, his
alarm is issued.

for XPIC

Linearizer Function

Indicates the status of linearizer function.

OPR: When the linearizer function is used.
NO OPR: When the linearizer function is not used.
In this case, TX output power decreases
approx. 4 dBm from a standard value.
When the ODU is used without linearizer
function.

N/A:

None

Linearizer /| MODEM
Linearizer

Indicates the linearizer operating status; this alarm is
issued when the linearizer is not properly operating in
the OPR state.

None

ATPC Power Mode

Indicates the operating status of the ATPC. If the
ATPC is not properly functioning, stop the control and
maintain the TX output level at HOLD /MIN
(selectable).

Only when ATPC is used
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2.14 MAIN (WORK) Interface Tab

The MAIN (WORK) tab displays the status of the monitored items for the main (work)
interface. This window only displays current settings and no control functions are available

here.

ROI-S07052

To set the Main (work) interface parameters see the chapters on Equipment Setup and

Provisioning.

To view the alarms and status of the main (work) interface:

1. Click the respective MAIN(WORK) field in the PNMT main window of the target

NE.

- Detail = No.001

Category ftem Status
Comman MTFC ) Unecuipped ormal
Comman MTFC1) Type Mismatch armal
Comtmon MTFC ) Module armal
Commaon GhE LAN Link Port ortmal
Comman ZhE Speed & Duplex 000k-Full
Camtmon STM-1017 LOS[DMR) ormal
Comman STh-1017 LOF(DMRE) ormal
Common STM-101) E-BER(DMR) ormal
Camtmon STM-101) SDIDMR) armal
Comman STh-101) TF ormal
Common STh-101) UAECDRMR) armal

ool | MODEM | mamceork | SUBKROT) | auxuo | TRL | nventory |

Overview and description of the monitored items for the Main (Work) interface

ltem/Feature

Description

Specific conditions for it to
be displayed/configured

INTFC (1) Unequipped

Indicates whether there is any Main Interface. If there
is no INTFC (1), this alarm is issued.

None

INTFC (1) When this alarm is issued, it indicates that INTFC (1) | None
Type Mismatch does not correspond to the inventory list.
INTFC (1) Module Indicates the operating status of the MAIN INTFC. If None

any anomaly occurs in the MAIN INTFC, this alarm is
issued.

LAN Link Port (1-2) (Main)

Indicates the LAN Link Port status: an alarm occurs
when the link fails for the respective ports.

The respective Port Usage
must be set at "used"

GbE LAN Link Port

Indicates the GbE LAN Link Port status: an alarm
occurs when the link fails

When Main(Work)-
INTFC(1)=GbE over STM-1 or
GbE over STM-1/300MB

LAN Collision Port
(2-2) (Main)

Indicates the status of any collision for the respective
ports

The respective Port Collision
Report function must be
enabled (set to "report”)

Link Loss Forwarding Port
(1-2) (Main)

Indicates the status of Link Loss Forwarding status for
the respective ports

The Link Loss Forwarding
function must be "enabled"

GbE Link Loss Forwarding
Port

Indicates the status of GbE Link Loss Forwarding
status

When GbE LINK LOSS
FORWARDING=ENABLED

Speed & Duplex Port (1-2)
(Main)

Indicates the status of LAN Mode (Speed & Duplex) for
the respective ports

The respective Port Usage
must be set to "used"

GbE Speed & Duplex

Indicates the status of GbE LAN Mode (Speed &
Duplex)

When Main(Work)-
INTFC(1)=GbE over STM-1 or

GbE over STM-1/300MB
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ltem/Feature

Description

Specific conditions for it to
be displayed/configured

STM-1 (1) LOS (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the input is disconnected this alarm is issued.

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical)

STM-1 (1) LOF (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the input signal is out of frame
synchronization, this alarm is issued.

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical)

STM-1 (1) E-BER (MUX)

Indicates Excessive-BER of the input STM-1 signal
from MUX. If the signal deteriorates below the present
threshold level, this alarm is issued. The settable
threshold values are 1E-3, 1E-4 and 1E-5.

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical)

STM-1 (1) SD (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the signal deteriorates below the preset
threshold level, the alarm is issued. The selectable
threshold values are: 1E-6, IE-7, 1E-8 and 1E-9.

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical)

STM-1 (1) LOS (DMR)

Indicates the signal status of the STM-1 from DMR. If
the input is disconnected, this alarm is issued.

When Transmission
Capacity=156MB

STM-1 (1) LOF (DMR)

Indicates the status of the input STM-1 signal from
DMR. If the input signal is out of synch, this alarm is
issued.

When Transmission
Capacity=156MB

STM-1 (1) E-BER (DMR)

Indicates Excessive-BER of the input STM-1 signal
from the DMR unit. If the signal deteriorates below the
present threshold level, this alarm is issued. The
settable threshold values are 1E-6, 1E-7, 1E-8 and IE-
9.

When Transmission
Capacity=156MB

STM-1 (1) SD (DMR)

Indicates the input signal status of the STM-1 from
DMR. If the signal deteriorates beyond the preset

threshold level, this alarm is issued. The selectable
BER threshold values are 1E-3, 1E-4 and 1E-5.

When Transmission
Capacity=156MB

STM-1 (1) TF

Indicates "alarm" when there is a defect in this
interface that interrupts the STM-1 signal

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical), or Main(Work)-
INTFC(1)= GbE OVER STM-
1 or GbE OVER STM-
1/300MB and GbE MEDIA
TYPE ="SFP"

STM-1 (1) UAE (DMR)

Indicates whether UAS were monitored (in DMR)

None

STM-1 (1) UAE (MUX)

Indicates whether UAS were monitored (in MUX)

When Main(Work)-
INTFC(1)=STM-1(Optical),
STM-1(Electrical), 2xSTM-
1(Optical) or 2xSTM-
1(Electrical)

INTFC (1) In-phase

Indicates the DADE status of the received No.1 and
No.2 signal. If the received signal delay time is out of
the permissible range, an "Out-of-phase" alarm is
issued

Only for 1+1 hot standby or
Twin path

STM-1 (1) Output Control

Indicates signal interruption status when MS-AIS
Generation is set to "Disable". Indicates UNDER
EXECUTION, when there is no STM-1 output signal
from STM-1 INTERFACE

Only when MS-AIS
Generation is "disabled”
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2.15 SUB (PROT)

Interface Tab
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The SUB (PROT) Interface tab displays the status of the monitored items for the SUB
(PROT) interface. This window only displays current settings and no control functions are

available here.

To set the SUB (PROT) interface parameters see the chapters on Equipment Setup and

Provisioning.

To view the alarms and status of the SUB (PROT) interface:

1. Click the respective SUB(PROT) field in the PNMT main window of the target NE.

- Detail = Ho.001

Category

ttem

Status

Commaon

MTFC(2) Unequipped ormal

Commaon

MTFC(2) Type Mismatch ormal

Commaon

MTFC(2) Module ormal

Commaon

LAMN Link Port1(SUE) ormal

Comman

LA Link Port2(SUE) o ial

Commaon

L& Collision Port1(SUE) ormal

Commaon

L&k Collision Port2(SLIE) ormal

Caomman

Link Lozs Forwarding Port1(SUB) o thial

Commaon

Link Loz=s Forvwarding Port2(SUB) ormal

Common

Speed & Duplex Port (SUE) Ohd-Half(MD)

Comman

Speed & Duplex Part2(SLE) OM-Half(MD)

4

0D | ODU2 | MODEMI | MODEMZ | MAINGAORK)

SUB(FROT) | AUKNO || CTRL | Invertory |

Overview and description of the monitored items for the SUB(PROT) interface

Item/Feature

Description

Specific conditions for it to
be displayed/configured

INTFC (2) Module

Indicates the operating status of the SUB INTFC. If
any anomaly occurs in the SUB INTFC, this alarm is
issued.

Only when SUB interface is set

INTFC (2) Unequipped

Indicates whether there is any SUB Interface. If there
is no INTFC (2), this alarm is issued.

Only when SUB interface is set

INTFC (2)
Type Mismatch

When this alarm is issued, it indicates that INTFC (2)
does not correspond to the inventory list.

Only when SUB interface is set

STM-1 (2) LOS (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the input is disconnected this alarm is issued.

Only when APS Function is
available

STM-1 (2) LOF (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the input signal is out of frame
synchronization, this alarm is issued.

Only when APS Function is
available

STM-1 (2) E-BER
(MUX)

Indicates Excessive-BER of the input STM-1 signal
from MUX. If the signal deteriorates below the present
threshold level, this alarm is issued. The settable
threshold values are 1E-3, 1E-4 and 1E-5.

Only when APS Function is
available

STM-1 (2) SD (MUX)

Indicates the input signal status of the STM-1 from
MUX. If the signal deteriorates below the preset
threshold level, the alarm is issued. The selectable
threshold values are: 1E-6, IE-7, 1E-8 and 1E-9.

Only when APS Function is
available

STM-1 (2) LOS (DMR)

Indicates the signal status of the STM-1 from DMR. If
the input is disconnected, this alarm is issued.

Only when APS Function is
available

STM-1 (2) LOF (DMR)

Indicates the status of the input STM-1 signal from
DMR. If the input signal is out of synch, this alarm is
issued.

Only when APS Function is
available

LAN LinkPort (1-2)

(SUB)

Indicates the LAN Link Port status: an alarm occurs
when the link fails for the respective ports.

The respective Port Usage must
be set at "used"
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Item/Feature

Description

Specific conditions for it to
be displayed/configured

LAN Collision Port
(1-2) (suB)

Indicates the status of any collision for the respective
ports

When WS/LAN or WS/LANZ is
SUB

The respective Port Collision
Report function must be enabled
(set to "report")

Link Loss Forwarding
Port (1-2) (SUB)

Indicates the status of Link Loss Forwarding status for
the respective ports

When WS/LAN or WS/LAN2 is
SUB.

The Link Loss Forwarding
function must be "enabled"

Speed & Duplex Port
(1-2) (suB)

Indicates the status of LAN Mode (Speed & Duplex) for
the respective ports

When WS/LAN or WS/LANZ is
SuUB

The respective Port Usage must
be set to "used"

STM-1 (2) E-BER
(DMR)

Indicates Excessive-BER of the input STM-1 signal
from the DMR unit. If the signal deteriorates below the
present threshold level, this alarm is issued. The
settable threshold values are 1E-6, 1E-7, 1E-8 and IE-
9.

Only when APS Function is
available

STM-1 (2) SD (DMR)

Indicates the input signal status of the STM-1 from
DMR. If the signal deteriorates beyond the preset
threshold level, this alarm is issued. The selectable
BER threshold values are 1E-3, 1E-4 and 1E-5.

Only when APS Function is
available

INTFC (2) In-phase

Indicates the DADE status of the received No.1 and
No.2 signal. If the received signal delay time is out of
the permissible range, an "Out-of-phase" alarm is
issued

Only when APS Function is
available and only for 1+1 hot
standby or Twin path

STM-1 (2) TF Indicates "alarm” when there is a defect in this Only when APS Function is
interface that interrupts the STM-1 signal available

STM-1 (2) Indicates the operating status of the LAN/WS. Only when WS is set

WS Input LOS When E1 WS input signal falls below the threshold,

this alarm is issued.

WS AIS Received

Indicates the E1 signal transmitting status. If AIS is
received from MUX, this alarm is issued.

WS is set and AIS Received
Report function must be enabled
(set to "report").

WS AIS Generated

Indicates the E1 signal receiving status. If AlS is
generated in the E1 INTFC, this alarm is issued.

WS is set and AIS Generated
Report function must be enabled
(set to "report")

STM-1 (2) Output
Control

Indicates signal interruption status when MS-AIS
Generation is set to "Disable". Indicates UNDER
EXECUTION, when there is no STM-1 output signal
from STM-1 INTERFACE

Only when APS Function is
available and MS-AIS Generation
is "disabled

STM-1 (2) UAE (DMR)

Indicates whether UAS were monitored (in DMR)

Only when APS Function is
available

STM-1 (2) UAE (MUX)

Indicates whether UAS were
monitored (in MUX)

Only when APS Function is
available
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2.16 Auxiliary I/O Tab

6 photocoupler input and 4-relay output settings can be selected in the IDU for external
control and monitoring of alarms. The setting for each of the relay output/photocoupler inputs
is available by clicking on the respective device in the Auxiliary I/O monitor window.

To monitor and set the Auxiliary 1/O:

1. Click the respective AUX I/O field in the PNMT main window of the target NE.

' Detail - No.001 =13
Categary ftem Status
Commaon Auin-1 (Input-11 CpeEn
Comman Audn-2(input-2) Cpen
Cammon Auzin-3(Clusterd) Open
Comman Aun-4(Clusters) Cpen
Commaon Auxin-S(input-51 CpeEn
Comman Aun-B(Clustert ) Cpen
Commaon AveeOut-1(Output-1) Open
Camman A Cut-20 Cutput-2) Cpen
Commaon AveeOut-300utput-3) Open
Comman Auiout-40Output-4) Open
oD | oDUZ2 | MODEMI | MODEMZ | MAINGACRK) | SUB(PROT)  auxyo | CTRL | Inwertary
B RIS -—————

AUX. I/O window

2.16.1 Monitored Items
The following items are monitored via this tab:
1. Six (6) photocoupler inputs. (Input-1 to Input-6)
2. Four (4)-relay outputs. (Output-1 to Output-4)

When Cluster ALM Setting (Input) is enabled, the following Input items can be used as
Cluster ALM.

1. When Clusterl Input is enabled, Input-6 item is used as Cluster ALM1.
2. When Cluster2 Input is enabled, Input-5 item is used as Cluster ALM2.
3. When Cluster3 Input is enabled, Input-4 item is used as Cluster ALM3.
4. When Cluster4 Input is enabled, Input-3 item is used as Cluster ALM4.
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2.16.2 Photocoupler Input Setting

To set the photocoupler input:

1. Click the selected [Input-n] button in AUX. I/O window.

2. The input properties will be displayed in the ensuing window.

Input=1 E“§|E|

o0

Mame

[input-1

Condition

(@) Alarm when Event OMCloze)
23 Alarm when Evert OFF(Oper)
) Status

Status Strings

Evert ON[Cloge):  |Alarm
Event OFF(Cpen):  |Mormal

]

Severity: mjar -
Alarm Type equipmentlarm -
Probable Cause:  |eguipmerthdaliunction e

Close

2.16.2.1 Setting the Selected Input to Alarm or Status

1.

Enter the desired name of the selected input in the Name field. A maximum of 32
characters can be used.

Select the desired input condition in the Condition section. You can select from the
following three (3) choices such as “the alarm is reported when Event ON (the
selected input terminal is closed loop condition)” or “the alarm is reported when
Event OFF (the selected input terminal is open condition)” or “the just Status
information is reported instead of the alarm”.

Enter the status strings corresponding to the input condition in the Event ON and
Event OFF field in the Status Strings section. A maximum of 32 characters can be
used.

The alarm input severity is defined in the ITU-T X.733 Recommendation. Select the
description of the Severity, Alarm Type and Probable Cause fields in the X.733
section by clicking the pull-down arrow (¥) on the right-hand side of the selection
field.

Click [Execute] button to save the selected settings of the device.

Click [Close] button when finished.
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2.16.3 Relay Output Setting

To set the relay output:

1. Click [Output-n] button in AUX. I/O window.

Dutput—1 [Z“E|E|

flo. 001

2. Enter the desired name of the selected output in
the Name field. A maximum of 32 characters can
be used. ame

OutpLt-1 |

3. To select the desired output condition of the
selected relay output, select the Event ON (the

output terminal will be in closed loop condition) or | - Evert ON(Close)  |Close

Event OFF button (the output terminal will be @) Event OFF(Open) [Open
open) in the Control section.

4. Enter the desired status strings for the selected

relay output in the appropriate Event ON (the
output terminal will be in closed loop condition) and Event OFF fields (the output

terminal will be open) with the Control section. A maximum of 32 characters can be
used.

Contral

5. Click [Execute] button to implement the command.

6. Click [Close] button when finished.
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2.17 Control (CTRL) Tab

Various control parameters can be set via the CTRL tab.

Detail - No.001

ROI-S07052

EEX

Categary

tem

Status

Cammon

CTRL Mocule

ormal

Cotman

MC hount

Off

Cammon

CTRL

ormal

Comman

PIC Mode Mismatch

Jormal

DiatelTime

CPU Reset

DL

Configuration File

DL

Program File

DL

Equipment Config. File

DL

Software Key File

UL

Configuration File

UL

Equipment Config. File

UL

Software Key File

Equipment Metwiork Setting

2171

The following items can be monitored and controlled in the CTRL window:

oD

Control Module

CTRL | Imvertory

CTRL window

1. Click the respective CTRL field in the PNMT main window of the target NE.

CTRL Module Alarm
MMC Mount (Yes = On / No = Off)
APS SW Fail (when APS is available)

APS Online Status (indicates route when APS is available)

APS Lock-in Status (when APS is available and Lock-in Usage is selected as “Used”)

XCTRL (when XPIC Usage is selected as “Used” and the control signal between

Master and Sub Master IDU is lost; this alarm is issued)

XPIC Mode Mismatch (when XPIC Usage is selected as “Used” and is incorrectly
defined [e.g. Main Master to Main Master, Sub Master to Sub Master]; alarm is

issued)

Date/Time
CPU Reset

Download: Configuration File

Download: Program File

Download: Equipment Configuration File

Download: Software Key File

Upload: Configuration File

Upload: Equipment Configuration File
Upload: Software Key File
Equipment Network Setting

-33-



ROI-S07052

2.17.2 Setting the Date/Time

The Date and Time stored in Control module can be displayed and adjusted using this
function.

To set the Date/Time:

1. Click the [Date/Time] button in the CTRL window.

B Date/Time E“E|E|

Moo

fdade

NOTE

) Get DatefMime (@) Set DatelTime
To synchronize the Date and

DatsTime Time field values with those of

Dete |03/01/2006 Time [12:08:35 the PNMT computer, click the
[ Gisplay PC Time Display PC Time box (placing a

checkmark in it).

| Execute || Close |

2. To check the Date and Time Settings of the Control module:
1) Select Get Date/Time in the Date/Time window.
2) Click [Execute] button.

3) The current date and time in the Control module will be displayed in the Date
and Time field.

3. To set the Date and Time on the Control module:
1) Select Set Date/Time in the Date/Time window.
2) Click [Execute] button.
3) Click [Close] button when done.

2.17.3 CPU Reset
The Control module can be reset using this function

*The CPU Reset window is not available when MAINT is OFF.

NOTE

Resetting the Control module will not affect traffic. The
connection to the selected NE will be disrupted for a few
minutes but will be automatically restored.
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To reset the Control module:

1. Click the [CPU Reset] button in CTRL window.

2. You can select the “with ROM (Program) Switching”
option if you want to switch to a newly downloaded

Control module Program file.

3. Click [Execute] button to continue the Control module

reset operation.

ROI-S07052

B GPU Reset

=3

Ty 001

fdadule Select
@ CTRL

i onu
@ Not () MNo2

|:| wyith ROMProgram) swwitching

| Execute || Close

2.17.4 Downloading the Configuration Files to the Control Module

This function is used to download the network configuration files from the PNMT to the
Control module. The network configuration file — pp_network.cfg, contains the IP address of
the target NE as well as the IP address of the opposite NE and the information about the
network where the target NE is located. The pp_mib.cfg file contains relevant information
about the equipment (i.e. name, pm type, etc.) and housekeeping (AUX. I/O).

*This window is not available when MAINT is OFF.

To download the new configuration file to the CTRL:

1. Click [DL Configuration File] button in CTRL window.
oK

Download Configuration File

Download Configuration File

M9[S1ES

o0

Metweark Config =

Type

File

o001
Type

ikx Config =

File:

|c:: netweark .oty

| Erowse

|u::1mib .cfiy

| | Brovwrse |

| Execute || Updiate... ||

Close |

| Execute || Update.

Close |

2. Select the type of file to be downloaded in the Type list.

3. Enter the location of the configuration file in the File field, or click [Browse] to locate
the file on the local hard disk or diskette.

WARNING!!!

Make sure that the correct configuration file is
downloaded to the correct Control module. An
incorrect configuration file may lead to Control module
or network malfunction/failure.
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4. Click the [Execute] button to start the operation.

WARNING!!!

While data is being transmitted, do not remove the USB
cable connecting the IDU with the PC.

5. A message window indicating the status of the operation will appear. It will close
automatically once the operation is finished.

WARNING:

Make sure that you have successfully downloaded the
configuration file before executing Update. Otherwise
the Control module will switch to an empty ROM that
may cause Control module malfunction/failure.

6. Click the [Update] button to activate and save the new configuration file (s).

B Update Gonfiguration File E|§|EJ

o001
File
Metwwork Config
MIE Config

| Execute || Close |

7. Select the appropriate box for the type of configuration file to be updated. One or
more configuration file(s) can be updated by checking the selection box of the
configuration file name. Click [Execute] to start the operation. The "with ROM
(CTRL Program) Switching" box is for switching to the ROM with the new CTRL
Program and has the same function that was previously described in section 2.17.5
Downloading a new Program file to the Control Module.

NOTE

When updating the pp_network.cfg file, NE-to-NE
communication will be disrupted when the Control
module reinitializes to the new system configuration. This
WILL NOT affect the wireless link. During this time PNMT
connection to the NE will be disrupted but will
automatically be restored after the Control module is
reset.

8. Click the [Close] button when done.
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2.17.5 Downloading a new Program File to the Control Module

This function is used to update the application program on the Control module. This
operation only affects the NMS communication but not the wireless link, and will not disrupt
communication.

*This window is not available when MAINT is OFF.
To download the program file to Control module:
1. Click the [DL Program File] button in CTRL window.

2. Select the module select button.

Download Proeram File Q|§|El

3. Enter the appropriate location of the program file
(*.pfp) in the File field. Otherwise, click [Browse] L2l
to locate the file. Module Select

0] Package Program
WARNING!!! 5 onu

Make sure that the correct program file is
downloaded to the Control module. Incorrect

program files are likely to cause malfunction Filz

| | Brovwvse
| |
4. Click the [Execute] button to start the operation. | CPUResst || s |

WARNING!!!

While data is being transmitted, do not remove the USB
cable connecting the IDU with the PC.

5. A message window will appear displaying the status of the operation. The message
window will close automatically once the download is completed.

GPU Reset =13

NOTE Ma.0m
This operation may take several minutes (ifslul> SetaE!
depending on the program file size. ® crrL
oDy
6. Click the [CPU Reset] button to switch to the new program ® ot (b2

file.

7. Check the with ROM (Program) Switching box.

. ) D wvith ROM(Program) sswitching
8. Click the [Execute] button to complete the switch to the

new program file. | Beate || liose

NOTE

The connection to the selected NE will be disrupted for a
few minutes, but will be automatically restored shortly.
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2.17.6 Downloading the Equipment Configuration Files to the Control Module

This function is used to download equipment configuration files from the PNMT to the Control
module. The equipment configuration file contains the wireless configuration data (i.e.
frequency, main interface) and provisioning data (i.e. BER alarm threshold).

*This window is not available when MAINT is

OFF Download Equipment Confie. File g|§|g|
To download new configuration file to the NE: Mo.001
File
1. Click the [DL Equipment Config. File]

button in CTRL window.

Header Infarmation

2. Click the [Browse] button to locate the NE_MAME="ho.001"
. H H IP_ADDRESS="1721801"
file on the local hard disk or diskette. EGUPMENT TYPE="Pasoiieokp®
SUB_TvPE=""

DATE="2006/0301 132951

WARNING!!!

Make sure that the correct equipment
configuration file is downloaded to the
correct Control module. Incorrect
configuration file is liable to cause
Control module or network
malfunction/failure. Execute || Update... || Cloze

3. Click the [Execute] button to start the operation.

4. A message window indicating the status of the operation will appear. It will close
automatically once the operation is finished.

WARNING:

Make sure that you have successfully downloaded the
configuration file before executing Update. Otherwise the
Control module will switch to an empty ROM that is liable
to cause Control module malfunction/failure.

5. Click the [Update] button to activate the new equipment configuration file. Click the
[Execute] button to start the update operation.

Update Equipment Gonfie. File glilgl
o001

File:
Equipment Config

| Execute || Close

6. Click the [Close] button when done.
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2.17.7 Downloading the Software Key Files

This function is used to download the Software Key file from the PNMT to the Control module.
The Software Key file is used to enhance PNMT functionality.

*This window is not available when MAINT is OFF.

To download the Software Key files:

Download Software Key File |:||:Irg|

Mo 001
File

Information

Categary ltem File Status Equipment Current Status

ey Serial Mo, 0 -

CTRL Serial Mo. 0 0

Capacity SEME]

Fedundancy +0 +1

Capacity&Redundancy Frecheck Enable OFF

Capacitylprevious)

Fedundancypreyvious) - +1

Fiit Fres

Eit Fate Free Frecheck Enable

Eit Free(previous)

LAM

L AR IMTFC Frecheck Enable

L ARprevious)
PIC

FIC Precheck Enable

PlC{previous)

Comman

| Execute || Upciate || Close |

1. Click the [DL Software Key File] button in CTRL window.

2. Click the [Browse] button to locate the file on the local hard disk or diskette.

WARNING!!!

Make sure that the correct Software Key file is
downloaded to the correct Control module. Incorrect
Software Key file is liable to cause Control module or
network malfunction/failure.
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3. Click the [Execute] button to

start the operation.

4. The values of “Equipment

Current Status” are updated.

5. Click the [Update] button to

activate the new Software Key
file. “Update Software Key File”
window is displayed.

6. Select the File to update and

click the [Execute] button.

7. Click the [Close] button when

done.

Update Software key File

Mo 0012

Information

ROI-S07052

Categary File: ftett

File Status

Comman CTRL Serial Mo.

0

ey Serial Mo,

al

Capacity

S6[ME]

Frecduncanc
¥

+0

Capacity &Redundancy ————

OFF

Capacity(previous)

Fedundancy(previous)

ey Serial Mo,

Eit i
Eit Feate Free res

Free

Precheck Enable

COFF

Eit Free(previous)

ey Serial Mo,

0

Y
LN INTFC

Svailakle

Precheck Enable

OFF

L AN previous)

ey Serial Mo,

al

o Fic

Lvailable

Precheck Enable

PIC(previous)

OFF

Execute | | Cloze

Uploading Configuration File to PNMT PC

This function is used to upload the configuration file from the Control module of the selected
NE to the PNMT PC.

To upload the configuration file from the Control module to the PNMT:

1. Click the [UL Configuration File] button in CTRL window.

Upload Gonfiguration, File |Z||§|rg| Upload Gonfiguration File |Z||E|r5__(|
o001 Mo.00
Type Type
e e [ T
File: File
|c::1netwnrk.cfg | | Birourse | |-::1.mib.cfg | Browse
I | |
| Execute | | Cloze | | Exgcute | | Close |

2. Select the type of file to be uploaded onto the Type field.

3. Enter the desired file name for the uploaded file. And select and the directory where

the uploaded file is to be saved.

4. Click the [Execute] button to start the operation.

5. A message window indicating the status of the operation will appear. It will close
automatically once the operation is completed.

6. After the upload is finished, click the [Close] button.

7. Verify that the file was uploaded to the specified directory.
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2.17.9 Uploading Equipment Configuration File to PNMT PC

This feature is used to upload the equipment configuration file from the Control module of the
selected NE to the PNMT PC.

To upload the equipment configuration file from
the Control module to the PNMT:

Upload Equipment Gonfie. File |z”§|r5__(|
1. Click the [UD Equipment Config. File] Mo 001
button in CTRL window. File:
|C:1.equipment.cfg | Brovyse

2. Enter the desired name for the uploaded
file and select the directory where the | |
uploaded file is to be saved. e || Close |

3. Click the [Execute] button to start the
operation.

4. After the upload is finished, click the [Close] button.

5. Verify that the file was uploaded on the specified directory.

2.17.10 Uploading Software Key File to PNMT PC

This feature is used to upload the equipment configuration file from the Control module of the
selected NE to the PNMT PC.

E Upload Software Key File

To upload the equipment configuration file o, 0012
from the Control module to the PNMT: Infarmation
. . Category ftem File Status
1. Click the [UD Software Key Fi |E] Caiman CTRL Serial Mo, 0
button in CTRL window. &y Setial o, D
Capacity SE[ME]
2. Click the [Execute] button to start CapactyaRedundancy redundancy -
. Frecheck Enable OFF
the Operatlon . Capacity(previous)
. o . Fedundancy(previous)
3. After the upload is finished, click the ey Serial Mo D
[Close] button. Eit Rete Fres pi Free fres
Frecheck Enable OFF
Eit Free(previous)
ey Serial Mo, 0
| AN NTFC LAk Aeailable
Frecheck Enable FF
L AR previous)
ey Serial Mo, 0
Pic Pl Aeailable
Frecheck Enable FF
PICiprevious]
|
Execute | | Close

-41 -



2.17.11 Configuring the Equipment Network Settings

ROI-S07052

In order to operate Auto Discovery and Network function respectively to PNMS and PNMT it
is necessary to first, connect PNMT to all equipment to configure Network data.

This function is used to configure the equipment network settings (i.e. IP and routing
addresses, subnet masks) using the tags in the lefthand field of the Equipment Network
Settings window of the selected NE for the PNMT PC.

.« Detail — No. 001

FEX

Categary

Status

Configuration File

| »

Program File

Eqjuipment Config. File

Softweare Key File

Configuration File

Equipment Config. File

Qituare bew Fls

Eqjuipment Metwork Setting

<]

oot | couz | wmooemt | mobeEw

' TETPRT] i f-\ukm_l Inverrtory_l

Equipment Network Setting

FEX

T 00
MI General
Radio/EMTEM2
Rauting System
Equipment Type: | | |
CTRL Type
CTRL Type: IMarmal NE |
Branch ME Type: | | |
Port Information
Part | Paddress | Subnet Mask
FadioEMTEM2 0.0.on 0.o.on
I
Execite ‘ | Claze
For details, refer to Appendix A.
Reserved Iltem

NOTE

Since, the following IP addresses are
reserved for NEC’'s Radio Equipment,
they cannot be set in this window’s IP

address column.

IP addresses

172.17.251. XXX

Unnumbered PPP IP Address

172.17.252 XXX

Unnumbered Async/
LAN IP Address

172.17.254.253

PNMT IP Address

172.17.254.254

PNMT IP Address
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2.18 Maintenance

ROI-S07052

There are several maintenance control items that can be set during Maintenance Mode.

The function of each control is as follows. (These windows are not available when MAINT is
OFF. “Switch to Maintenance mode first” is displayed).

Maintenance:

TX SW Manual Control:
RX SW Manual Control:
ATPC Manual Control:
TX Mute Control™ "%
CW Control™:

IF Loopback™®:

DADE Adjust:

LAN Device Reset:
RF Setting™:

XPIC Control

Antenna Alignment Mode™ 2

X-DEM Delay Adjust™:

APS Manual Control:

Main Loopback-1 INTFC (1) :
Main Loopback-1 INTFC (2) :
Main Loopback-2:

ALS Restart:

To switch Maintenance mode to ON

To control the TX switch manually (Only during hot-standby)
To control the RX switch manually (Only for 1 + 1 systems)
Allows optional transmitting power when ATPC is in operation
To set TX Mute Control

To turn on the Carrier Wave for measurements

To pinpoint faulty sections causing signal interruption

Select the DADE for Hot-Standby / Twinpath configuration to
bring INTFC status back in phase

Resets LAN INTFC ports (when LAN Port setting is “used”)

To change the ODU sub band for the wireless link according
to the RF frequency allocation

To temporarily interrupt XPIC (when XPIC is available)

To turn on Antenna Alignment Mode
(only available for specific ODU type)

To adjust the transmission delay between Main Master and
Sub Master caused by XPIC. (Available only when XPIC is in
use.)

Allows APS to be manually controlled (when APS is
available)

Allows the pinpointing of signal interruption faults
Same as above (when APS is available)
Same as above

For optical interfaces, the duration of laser emittance
during ALS manual restarts (for testing)

*1 - Operation is possible only when NE directly connected to PNMT appears in “Selected

Network Element” side.

*2 - Operation is possible only when NE opposite to the one directly connected to PNMT
appears in “opposite Network Element” side.
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2.18.1 Selecting Maintenance

To open the Maintenance window:

ROI-S07052

1. Select Configuration - Maintenance in the NE-specific menu bar.

+ Maintenance — No 001

Categary

Cammon Maintenance Off

Common R S Manual Contral Auto
o1 ATPC Manual Contral Off
l\Jo.z ATPC Manual Cantral Off
fria TX Mute Cortrol ot
frioz T Mute Cortrol o1t
fria s Y Cartral o1t
frio2 Y Cartral o1t
frio 1 IF Loophack ot
l\Jo.z IF Loophack Off
Hcommon DADE Adjust
l:ommon LAM Device Reset
I\JD A Linearizer Control Auto
l\Jo 2 Linearizer Cortral Ao
frio 1 RF Setting
frioz RF Setting
frio Artenna Alignment Mode ot

Artenna Alignment Mocde

This window contains the setup information for MAINT and several maintenance control
items that need to be set during Maintenance Mode. The Maintenance window is shown
below.

2.18.2

Mode

To switch the NE to maintenance mode:

1.

2
3.
4

Click [Maintenance] button in Maintenance window.

Select on ON/OFF depending on desired state.
Click the [Execute] to implement the command.

Click the [Close] button when finished.
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2.18.3 TX SW Manual Control (for Hot Stand-by system only)

To control the TX switch manually:

TA 5W Manual Control E”E|E|

Maintenance window. Mo.001
T S Manual Cortrol

2. Select the TX system that you want to use. The CiNod @ Auto O Moz

1. Click [TX SW Manual Control] button in

default setting is Auto.

Cloze

3. Click the [Execute] button to switch to the
selected TX system.

CAUTION:

Warning E|
_ o _ When TX SW Manual Control is changed from
A Ity I R e, the default setting (Auto) to either No.1 or

Az A0 U D BER L § No.2, this confirmation message appears.
[ TX =W Manual Cartrol - Ma 001 ]

If the TX SW Manual Control has been
manually switched to either No.1 or No.2, the
confirmation message will NOT appear.
However, this operation still may affect the
radio link.

| ik || Cancel |

4. Click the [Close] button when finished.

2.18.4 RX SW Manual Control (for 1+1 system only)

To control the RX switch manually:

1. Click the [RX SW Manual Control] button in B RX 5% Manual Gontrol |2 |0 |[X]
Maintenance window. N o
o001
2. Select the desired RX wireless system. The RS ETYE] CTie®
default setting is Auto. ot @ st O o2

3. Click the [Execute] button to switch to the RX

selected system.

4. Click the [Close] button when finished.

2.18.5 ATPC Manual Control

Use when an optional transmitting power is required during ATPC operation.
To set the ATPC Manual:

1. Click [ATPC Manual] button in Maintenance

ATPC Manual Gontrol

window.
Mool
2. Select whether to manually turn ON (or OFF) ATRC Manus! Control
ATPC manual power and the desired decibel ® on O off
value. ATPC hManual Control Power
3. Click the [Execute] button to activate the new o
setting.
| Execute || Close |

4. Click the [Close] button when finished.
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2.18.6 TX Mute Control

TX power of the ODU is switched off when TX Mute is ON.
This should be OFF in normal operation

To change the TX Mute status:

1. Click [TX Mute Control] button in Maintenance B T3 Mute ControltNo. 1) (2[5 [[X]

window. Mo.00
. . TX Mute
2. Select ON/OFF depending on the desired state. o
on @ Off

3. When setting the opposite NE, also select TX TX Mute Off Contral Time

Release Time in the TX Mute Release Time list.
4. Click the [Execute] button to implement the

command.

5. Click the [Close] button when finished.

2.18.7 CW Control

When taking frequency measurements, the CW should be turned ON to have an un-
modulated signal. During normal operation, this status should be OFF.

To change the CW (MOD Carrier) status:

B cw Controlio. 1) [2]5[[X]

1. Click [CW Control] button in Maintenance window.
Moo

Select ON/OFF depending on desired state. W Canitral

2

; . . 0 on @ off
3. Click the [Execute] button to implement the operation.
4

Click the [Close] button when finished.

2.18.8 IF Loopback
ODU or IDU faults can be pinpointed by looping back the MUX signal at the IF.

1. Click the [IF LoopBack] button in the B IF Loopback{No.1}
Maintenance window. s
2. Select ON to activate the loopback. [ —(I
IDU M+ ODbu
3. Click the [Execute] button to activate the |—
IOOpbaCk. IF Loophack
) on @) off

4. Click [Close] button when finished.

Cloze
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2.18.9 DADE Adjust

DADE adjustment is necessary when the IF cable is to be replaced. (At initial start-up the
offset memory can be used to minimize the delay, but it may interrupt traffic when the delay
is substantial).

To conduct DADE adjustment:

1. Click [DADE Adjust] button in Maintenance
window.

DADE Adjust =)0

frlo. 001

2. Select (click) the desired state: “DADE", “Offset
DADE”, or “DADE off". DEDE &djust

. . DADE () Offset DADE () DADE off
3. Click the [Execute] button to activate the ® s © ?

command. Execute | | Cloge
4. Click the [Close] button when finished.
2.18.10 LAN Device Reset
To reset Ports of LAN INTFC interface: B LAN Device Reset  [a |0 [[X]
1. Click [LAN Device Reset] button in Maintenance o001
WindOW. LAM Device Reset

O] IMTF Ci1 )-Port 1 (hiain)
2. Select the port that you want to reset. 2 INTFC(T)-Port20hin)
o INTFCC2)-Port1 (SUE)

3. Click the [Execute] button to reset LAN ports.
) INTFC(2)-Part 2 SUE)

4. Click the [Close] button when finished.

Execute | | Close

2.18.11 RF Setting
Sub Band of ODU can be selected
To select Sub Band:

RF Settine(No.1) A=
1. Click [RF Setting SUB Band] button in
Maintenance window. RF Setiing
2. Select the type of Sub Band in the Sub Band list. =UB Band A v |

3. Click the [Execute] button to implement the
command.

Execute | | Cloze |

4. Click the [Close] button when finished.
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2.18.12 Antenna Alignment Mode (only available for specific ODU type)

The Antenna Alignment Mode is used for extending the dynamic range of the RX LEVEL
MONITOR (ODU). This function is only available for a specific ODU type.

To set Antenna Alignment Mode:

1. Click [Antenna Alignment Mode] button & EIEELERITLL TR REISCERY =3
in Maintenance window.

2. SeleCt ON/OFF Antenna Alignment Mocde
ion ) Off

o 001

3. Click the [Execute] button to activate the

new setting.

4. Click the [Close] button when finished.

2.18.13 Main Loopback-2

This allows the signal sent from the opposite NE to be looped back (to that NE) from your
selected NE via the INTFC.

To set the loopback:

Main Loopback-2

1. Click the [Main Loopback-2] button in Ma.001
Maintenance window. — ’
2. Select On to activate the loopback. — by ( | 9bu _(\ «

Loopback-2

3. Click the [Execute] button to apply the
loopback. ©on @ ot

4. Click the [Close] button when finished.

2.18.14 APS Manual Control
To control the APS manually:
1. Click [APS Manual Control] button in Maintenance window.

2. Select the route you want to manually control:
Working, Auto or Protection. (The default setting is

o001
Auto)
APS Manual Contral

3. Click the [Execute] button to switch to the manual ) Warking @ Auto () Pratection

control of APS.

APS Manual Gontrol E”E|E|

4. Click the [Close] button when finished.
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2.18.15 Main Loopback-1 INTFC (1)

This type of Loopback is configured when the Selected NE currently connected has either
STM-1 (optical), STM-1 (Electrical), 2xSTM-1(Optical) or 2xSTM-1 (electrical) interface.

To set the near-end loopback:

Main Loophack-1 INTFG() [0 5|[]

1. Click the [Main Signal Loopback-1] button in Mo 01
the Maintenance window. —
2. Select ON to activate the loopback. ) IDU = ODbU _(I
3. Click the [Execute] button to apply the Loophack-1
loopback. Qron @ off
4. Click the [Close] button when finished.

2.18.16 Main Loopback-1 INTFC (2)

This type of loopback is created at the 156MB INTFC/OPT INTFC or 310MB INTFC/OPT
INTFC of the opposite NE.

Main Loopback-1 INTFG@ (20X

Mo 001

To set the opposite NE loopback:

1. Click the [Main Signal Loopback-2] button
in the Maintenance window. ) IDU — oODbu —(]

2. Select ON to activate the loopback.

Loopback-1

3. Click the [Execute] button to apply the Jon @ off

loopback.

4. Click the [Close] button when finished.

2.18.17 ALS Restart

This feature is used to set the time of manual restart of the Automatic Laser Shutdown (ALS).
When the optical input signal is lost, the IDU will emit a laser signal from STM-1 OUT at a
preset value (2 sec or 90 sec), at this point, if the fault has been rectified then the ALS will be
released and operation will return to normal. Otherwise, the laser emission will immediately
terminate.

To set the ALS restart:

1. Click the [ALS Restart] button in the ALS Restart =3
Maintenance window. -

Mio.001
2. Select the timing in seconds of the laser ALS Restart

emission for manual restart. ) 2secNTFEA)

3. Click the [Execute] button to apply the timing i) 90sec-NTFC(1)
of the manual restart.

4. Click the [Close] button when finished.
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2.18.18 XPIC Control
This feature is used to temporarily interrupt XPIC.

To set XPIC Control:

1. Click the [XPIC Control] button in TTITETTTET E|E|®
Maintenance window. ~ =

Mo .00
2. Select [Forced Reset]. U G
3. Click the [Execute] button to activate this ) Forced Reset @ Auto
command.
. . Execute || Cloze
4. Click the [Close] button when finished.

2.18.19 X-DEM Delay Adjust
This feature is used to adjust transmission delay between Main Master and Sub Master.
To set X-DEM delay Adjust:

1. Click the [X-DEM Delay Adjust] button
in Maintenance window.

B3 X-DEM Delay AdjustMo.1> (2]

To. 001

X-DEM Delay Adjust

2. Select [Forced Reset]. =

3. Click the [Execute] button to activate
this command. | i || Close |

4. Click the [Close] button when finished.

CAUTION:

When the value is changed to
adjust delay, the value for the
matching NE in pair must also be
adjusted.
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2.19 Equipment Setup

Main and Service signal, ODU and CTRL settings can be monitored as well as controlled via
this window.

2.19.1 Equipment Configuration window
To open the Equipment Configuration Monitor:
1. Select Configuration = Equipment Setup in the NE-specific menu bar.

2. This window contains the setup information and control parameters for the ODU and
the IDU. The Equipment Setup window is shown below.

4 Equipment Setup — No.001

List
Category ftem Status
armman Redundancy Setting +0( TERM)
l:ommon sin(ork) - INTFC(1) GHE over STM-1
l:ommon SUB(PROT) - INTFC(2) SILAN
ICommon FIC Usage Lzed(Main Master)
l:ommon odulation Scheme 2EEAM
l:ommon Tranzmizsion Capacity SE[ME]
ICommon Tx RF Freguency 500 .000[MHzZ]
l:ommon R RF Frequency 449 500[MHz]
l:ommon Frame T
l:ommon T Powver Control ATPC
l:ommon LAN Port Usage Lzed  P1-2 Shared Part Only(AS)
l:ommon Radio Mapping P=150[tbps] , P1-P2H P=200S)Mbps]
l:ommon IE Flame o001
l:ommon F Address 72.019.000.001
l:ommon AC Address 00-00-00-00-00-00
l:ommon Opposite-1 IP Address 72.019.000.002
OMIman Iote emo 1

Equipment Setup window (example shows GbE over STM-1 1+0 Configuration)

To edit the NE name:

1. Click [NE Name] button in Equipment Setup window. NE Name |—”—|r>—<|

2. Enter new NE name in the NE Name dialog box. A ha 001
maximum of 32 characters can be used.
ME Matne
3. Click the [Execute] button to change to new name. Mo 001
4. Click the [Close] button when finished.
Execute Cloze
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2.19.2 Editing the Note for CTRL

To put an optional description on the current NE:

2]

1. Click [Note] button in Equipment Setup window. No.001
2. Enter the optional description for the specific NE Mote
in the Note dialog box. A maximum of 100 hemo 1

characters can be used in this field.
3. Click the [Execute] button when finished.
4. Click the [Close] button when finished.

Execute | | Cloze

2.19.3 Setup
Setting the ODU and IDU parameters:

1. Click the [Setup] button in the Equipment Setup window and another Equipment
Setup window (for verifying the settings) opens.

Equipment Setup
ho.001
Equipment Setup
Redundancy Setting 1+1[Hot Standky TERM)
Inzerted Maciule
| MaingWork: - INTFC(1) STW-1(Optical) MainGAfark) - INTFCE1) SThi-1 (Optical)
SUE(PROT) - INTFC(2) STh-1(Opticsl) SUB(PROT) - INTFC(2) SThi-1(Optical)
XPIC Uzage Mot Lsed
APZ Function Unavailahle
Modulation Scheme 126Q4M
Transtizsion Capacity 15E[ME]
Mo 1 ko2
UpperiLower Upper UpperiLovyet Uppet
T Start Frequency 100.000|[MHz] TX Start Frequency
T Stop Freguency 1 632.001|[MHz] TX Stop Freguency
R Stert Frequency - Ivtz] R Start Frequency Iiz]
R¥ Stop Freguency [MHz] FX Stop Fregquency [MHz]
T RF Freguency 500.000/[MHz] | TX RF Frequency
RX RF Freguency 449 .500/[MHz] | R RF Freguency
Shift Freguency 50.500/[MHz] Shift Frequency
Freguency Channel Frequency Channel
Frame Ib 1 [ Frame \b
T Powwer Caontral ATPC
| Configure. .. | | Execute | | Cloze |

Equipment Setup Window (to verify settings)
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Equipment Setup
Mo.001
Equipment Setup
Redundancy Setting T+1(Hot Stanclby TERM)
GhE over STh-1/300ME SThi-1 (Optical)
WSLANZ ST (Optical)
HPIC Uszage Mot Used
APS Function
Mo tion Schere 25604
Transmission Capacity 400[ME]
o 1 ho.2
. UpperLavwer gt UpperiLower

T Start Freguency 100.000 [MHz] TX Start Frequency 100.000][MHZ]
T¥ Stap Freguency 1632.001 [MHz] Ti Stop Fregquency 101 [kHZ]
RX Start Frequency -|[MHz] £ R Start Frequency -[MHz]
R Stop Frequency -|[MHz] R¥ Stop Freguency - [MHz]
TX RF Freguency 500,000 [MHz] TX RF Frequency
R RF Frequency 449 500|[MHz] R RF Freguency

Shift Frequency 50.500 [MHz] Shift Fregquency
Freguency Channel Freguency Channs!

Frame ID 1 Frame D 1
TH Pawer Cartrol ATPC
LAN Port Settingrhd i L&R Port SettingrSUE)
LAN Port Usage Used L&M Port Usage P1-2 Sharedf Port Only(SC)
Raclio Magping P=400[Mbps] Raclio Magping P1-Fe2 P25 ]
| Configure | | Execute | | Close |

Main (Work) - INTFC (1): GbE over STM-1/GbE over STM-1/300MB
SUB (PROT) - INTFC (2): WS/LAN /WS/LAN2

Equipment Setup

Equipment Setup

Redundancy Setting

XPIC Uzage
APZ Function

Mo it
Transtizsion Capacity

che

Mo 1
| UpperiLovwer
TH .St.ari. Fréqﬁéncy
T Stop Freguency
R Star Freguency
R¥ Stop Freguency
T RF Frequency
R RF Frequency
Shift Frequency
Frequency Channel

Frame Ib

T.)(.Power .Co-l-'dro\.

1+1(Hat Standby TERM)

STH-1(Optical)
WSLAN

Mot Lsed

128G4M
156[ME]

Upper
) 100,000 [MHz]
1632001 [MHz]
itz
MHz]
500,000 [MHz]
449 500[MHz]
50.500MHz]

LTRC

Io.001

UpperiLovvet

TX Start F.requancy
TX Stop Freguency
R Star Frequency
FX Stop Fregquency
LCREFrenuaney:
R RF Freguency
] SHiﬂ Frequency
Frequency Channel

Frame \b

STMA1 (Cptical)
STH-1(Dptical)

100 [MHz]
1632.001 [MHzZ]
-[MHz)

L& Part SettingSUE)
L AhiGen A

Radlo‘ Mapping

Mot Used

| Configure. .. ||

Execute | | Close

Main (Work) - INTFC (1): STM-1 (Optical/Electrical)/2xSTM-1 (Optical/Electrical)
SUB (PROT) - INTFC (2): WS/LAN WS/LAN2
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2. Clicking Configure opens the Setup Wizard(1).

X

Equipment Setup Wizard

odify the equipment configuration settings.
This Wizard faciitstes modification of the equipment configuration settings.

To continue, click [Mext].

Redundancy Sefting  |[1+0(TERM) [~]
Inserted Module
MainCvark) - INTFC(1) || SThi-1 (Optical) - Main(vark) - IMTFCET ) STM-1(0ptical
SUB(PROT) - INTFC(2) || STh-1(Optical) - SUB(PROT) - INTFC(2) STM-1(0ptical
KFIC Usage [Mot Usea [~
£PS Function 0 Available @ Unavaiabls

| = Back

Setup Wizard(1)

I Mext = ||

Cancel

3. The settings in the window can now be configured. To continue click [Next].

Equipment Setup Wizard

Freguency Channel

Frame IC

T Povver Cortrol

odify the equipment configuration settings.

[ =]

CC—

Freguency Channel

Frame IC

Modulation Scheme 128G -
Transthission Capacity 156[ME] -
(=N Po.2
UpperiLower Upper UpperiLovwer

T Start Freguency 100.000([kHzZ] T Start Frequency [miHzZ]
T Stop Freguency 1632001 [MHz] T Stop Frequency [MHZ]
R Start Freguency -|[MHz] Fx Start Freguency [MiHz]
R Stop Freguency -|[MHz] R Stop Frecuency [MiHz]
T¥ RF Freguency S00.000 [kMHzZ] T¥ RF Fregquency [MHZ]
R RF Freguency [MHz] R RF Frequency [MHZ]
Shift Freguency 50,500 [MHz] Shift Freguency [kiHz]

[ T

X

| = Back

Setup Wizard(2)
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4. To complete the configuration procedure, click [Next] and in the ensuing window
click [Finish].

5. If LAN parameters need to be set, the following window will open.

After setting the LAN parameters, click [Next] and in the ensuing window click
[Finish].

Equipment Setup Wizard

odify the equipment configuration settings.

LM Part Setting (MAIN)

L&MN Port Usage | |

Rawdio Mapping

Capacity | |

LAN Part Setting (SUE)

L&N Port Usage P1-2 SharedHPort Cniy(ws) [~]
Rawdio Mapping
Capacity F1-P2 20 Mbps] [~]

= Biack I Mext = | Cancel

Main (Work) - INTFC (1): GbE over STM-1/GbE over STM-1/300MB
SUB (PROT) - INTFC (2): WS/LAN WS/LAN2
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Equipment Setup Wizard &|
odify the equipment configuration settings.

&N Port Setting (SUE)

LAN Port Usage P1-2 Sharedd Port Only(WS) [~

Radio Mapping

Capacity P1-F2 20M5)Mbps] [+]

| = Back I Mext = | Cancel

Main (Work) - INTFC (1): STM-1 (Optical/Electrical)/2xSTM-1 (Optical/Electrical)
SUB (PROT) - INTFC (2): WS/LAN WS/LAN2

6. This will take you back to the Equipment Setup window (for verifying the settings).
Carefully confirm that the settings are correct and click [Execute] to activate them.
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7. The following is an overview of the configurable items/parameters:

Redundancy setting:

Main (Work)-INTFC (1):

SUB (PROT)-INTFC (2):

XPIC Usage:
APS Function:

Inserted module:

Modulation scheme:

Transmission capacity:

TX RF Frequency:

Frequency Channel:

Frame ID:
TX Power Control:

LAN Port Usage:

To select the desired redundancy setting

To select the desired work interface (the available
options depend on the selected User Interface)

To select the desired protection interface (the available
options depend on the selected User Interface and Main
(Work) interface)

To select the XPIC Usage (where supported)

APS function can only be set when both Main (WORK)
and SUB (PROT) interfaces are STM-1 (optical)

This function is only enabled when the interface setting
and the actually inserted module do not match. It allows
the setting to be updated to match the inserted module

The type of modulation is set here

This value denotes the transmission capacity (in MB) of
the selected interface and modulation type

The transmission frequency can be set within the range
designated by the TX Start and TX Stop frequencies

Enables the TX and RX frequencies for the channels to
be set (as described below)

Identification code for the transmission frames
The type of power control is set here

To select the LAN Port Usage (the available options
depend on the selected User Interface)
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2.19.4 Frequency Channel

1. [Explain how to open Frequency Channel window.] To open [Frequency
Channel] Window, click [Frequency Channel] of Setup Wizard (2).

2. Click the [Browse] to locate the Channel plan file on the local hard disk.

3. Select Channel and click [OK], then TX and RX frequency corresponding to the
channel will be set.

Frequency channel file format is csv, including channel name, TX frequency and RX
frequency.

Examples
CH-1, 7442.000, 7603.000
CH-2, 7603.000, 7442.000

Frequency CGhannel [‘5_(|
Import Channel Plan
Channel Plan
Channel T Freguency[MHz] | RX Freguency[tHz]
ZH-1 7442000 7EO3.000
ZH-2 TEO3.000 7442 000
| (8] | | Cancel |
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This window enables the main interface (MAIN INTFC), SC Assignment, MTPC / ATPC
parameters, as well as error rate and other thresholds to be set.

Provisioning window

To open the Provisioning window:

1. Select Configuration - Provisioning in the NE-specific menu bar.

2. This window contains the setup information of the MTPC, ATPC, BER Alarm
Threshold, Cluster ALM Setting (Input), AIS Activation, SC and Assignment. The

Provisioning window is shown below.

+- Provisioning — No.001

Category ftem

High BER: Threshiold

Lovey BER Threshold

E-BER(DMR)

SO DM

E1 WS Usage

RS-232C-1

RE-2320C-2

SC4

W11-1

W11-2

=C2

S LANT

%11-2 Direction Setting

Co-directional

LAR Portd (Maim) Lzage

Lized

LAK Port1(SUEY Usage

ot Used

LAM Port2(SUE) Usage

ot Used

SUE Switching Function

Dizabled

GhE Media Type

SFP

GhE Speed & Duplex

AUTOMEG] Auto 1000 Full)

GhE Link Logs Forwarding

Dizabled

GhE Flovy Coritrol

o

ATPC Threshold Lewvel

_S[dEm]

Aclclitionzl ATT

3[dE]

ATPC Rangehs i

A0)

ATPC Rangebdrd)

[dE]

ATPC Povver hiode

Ird

CORM Alarm Maode

Huold

Relay Configuration

Cluster! Input

Enahled

Cluster Input

Dizabled

Clusters Input

Enahled

Clusterd Input

Enzhled

B2 External Setting

armal

R Levvel TCH Threshald

i 0[dBm]

SES Activation Condition

%]

Alarm Correlstion Capakility

o

Provisioning window
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ltem/feature Description Specific conditions for it to
be displayed/configured

High/Low BER Allows the setting of the BER value that will trigger the | None

Threshold alarm

E-BER (MUX) Sets the E-BER threshold for the multiplexer (MUX) When Main(Work)-
INTFC(1)=STM-1(Optical), STM-
1(Electrical), 2xSTM-1(Optical) or
2xSTM-1(Electrical)

E-BER (DMR) Sets the E-BER threshold for the digital microwave When Transmission

radio (DMR) Capacity=156MB

SD (DMR) Sets the Signal Degrade threshold for the DMR When Transmission
Capacity=156MB

SD (MUX) Sets the Signal Degrade threshold for the multiplexer | When Main(Work)-

(MUX) INTFC(1)=STM-1(Optical), STM-
1(Electrical), 2xSTM-1(Optical) or
2xSTM-1(Electrical)

RS-232C-11/ 2, Assigns the respective SC to an interface None
V-11-1/V-11-2
V-11-1/V-11-2 Enables the V-11-1/ V-11-2 service channel clocking | Only if SC have been assigned

Direction Setting

to be set (i.e. co-directional or contra-directional)

(without SC assignment it is
inactive)

STM-1 Usage

For enabling/disabling CHO2 of STM-1

Only for 2xSTM-1 (310MB
transmission)

MS-AIS Generation

For enabling/disabling the MS-AIS generation

When Main(Work)-
INTFC(1)=STM-1(Optical), STM-
1(Electrical), 2xSTM-1(Optical) or
2xSTM-1(Electrical)

ALS Function

The Automatic Laser Shutdown (ALS) that
intermittently turns the laser output on/off after a
designated interval from the start of LOS mode is
"Enabled" or "Disabled")

Only when Main(Work)-
INTFC(1)= STM-1(Optical),
2xSTM-1(Optical)

ALS Interval

For setting the interval (from the start of LOS) until
APS Function is to be executed.

Only when ALS Function is
enabled

RSOH CH select

Selects channel for dropping/inserting RSOH

When Main(Work)-
INTFC(1)=STM-1(Optical), STM-
1(Electrical), 2xSTM-1(Optical) or
2xXSTM-1(Electrical)

E1 WS Usage

Sets the E1 Wayside usage

When usable channel for E1 WS
is available.

WS Impedance

Sets the WS impedance

Only when WS is set

WS AIS Generated
Report

For enabling/disabling the AIS Generated Report

Only when WS is set

WS AIS Received
Report

For enabling/disabling the AIS Received Report

Only when WS is set

Port1-2 (Main/SUB)
Usage

For setting the usage of the LAN interface ports (Portl
(Main), Port2 (Main), Portl (SUB), Port2 (SUB))

Except when Port
Usage=INVALID

Speed & Duplex Portl-
2 (Main/SUB)

For setting the speed and duplex parameters of the
LAN interface ports (Portl (Main), Port2 (Main), Portl
(SUB), Port2 (SUB))

Only when Port1-2 (Main/SUB)

Flow Control Port1-2
(Main/SUB)

For setting the flow control parameters of the LAN
interface ports (Portl (Main), Port2 (Main), Portl
(SUB), Port2 (SUB))

Only when Port1-2 (Main/SUB)
Usage is set to Used

Collision Report Port1-
2 (Main/SUB)

For setting whether collision status is reported (or not)
for the interface ports (Portl (Main), Port2 (Main),
Portl (SUB), Port2 (SUB))

Only when Speed & Duplex
Portl-2 (Main/SUB) =
AUTONEG or HALF-DUPLEX

Link Loss Forwarding
Portl-2 (Main/SUB)

For enabling/disabling the Link Loss Forwarding
function for LAN interface ports (Portl (Main), Port2
(Main), Portl (SUB), Port2 (SUB)

Only when Port1-2 (Main/SUB)
Usage is set to Used
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ltem/feature

Description

Specific conditions for it to
be displayed/configured

Clock Source Setting

For setting the clock source of the LAN interface Port.

Only when Main (Work) —
INTFC(1) = 2Port LAN over STM-
1(LAN/WS) or 2Port LAN over
STM-1 over STM-1(LAN/WS2)

SUB Switching
Function

Allows the port switching function to be "enabled" /
"disabled"

Only when SUB (PROT)=
WS/LAN or WS/LAN2

GbE Media Type

Connector type for Ethernet cable port

Only when Main (Work) — INTFC
(1) = GbE over STM-1 or GbE
over STM-1/300MB.

GbE Speed & Duplex

For setting the GbE speed and duplex parameters of
the LAN interface Port

Only when Main (Work) — INTFC
(1) = GbE over STM-1 or GbE
over STM-1/300MB

GbE Link Loss
Forwarding

For enabling/disabling the GbE Link Loss Forwarding
function for LAN interface Port

Only when Main(Work)-
INTFC(1)=GbE over STM-1 or
GbE over STM-1/300MB

GbE Flow Control

For setting the GbE flow control parameters of the LAN
interface Port

Only when Main (Work) — INTFC
(1) = GbE over STM-1 or GbE
over STM-1/300MB

MTPC TX Power

Allows the transmission power (dB) to be set for MTPC
operation.

Only when Tx Power
Control=MTPC, XPIC Usage=Not
Used or Used(Main Master)

ATPC Threshold Level

Allows the transmission power (dB) thresholds to be
set for ATPC operation.

Only when XPIC Usage=Not
Used or Used(Main Master)

Additional ATT

For setting the additional attenuation parameters (dB)

Only when XPIC Usage=Not
Used or Used(Main Master)

ATPC Range
(Max / Min)

For setting the minimum and maximum ATPC
transmission power (dB).

Only when Tx Power
Control=ATPC, XPIC Usage=Not
Used or Used(Main Master)

ATPC Power Mode

For setting the power mode (Hold: maintaining present
status, MIN: minimum level).

Only when Tx Power
Control=ATPC, XPIC Usage=Not
Used or Used(Main Master)

COMM Alarm Mode

Select ODU output powermode when the
communication failes
between IDU and ODU due to some problemes.

When Mute is set, the ODU
output power will be muted.
(Default)

When Hold is set, the ODU
output power will be hold.
(Should consider neighboring
system)

TX / RX SW Priority

Enables the respective priority to be set
(pre-alarm TX / RX route or No. 1)

Only for 1+1 hot standby

TX SW Lock-in Usage

For setting the TX SW Lock-in Usage

Only when TX SW Priority is
"Priority No.1"

TX SW Reverse

For setting the TX SW Reverse Function

Only when TX SW Priority is

Function "Non Priority"

RX SW Has two settings: "manual” for disabling the RX switch | Only for 1+1
Maintenance Mode and “forced" for overriding the disabled switch. Hot Standby / Twin path
RX SW For setting whether the EW (Early Warning) feature is | Only for 1+1
Condition-Early to be included in the parameters. Hot Standby / Twin path
Warning

APS Maintenance
Mode

Has two settings: "manual” for disabling APS and
"forced" for overriding the disabled APS.

Only when APS Function is
enabled

APS Condition-SF

For setting whether Signal Fail is to be included in the
parameters.

Only when APS Function is
enabled

APS Condition-
Signal Degrade

For setting whether Signal Degrade is to be included
in the parameters.

Only when APS Function is
enabled

Lock-in Usage

Allows the Lock-in Usage to be "Used" or"Not Used"

Only when APS Function is
enabled
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ltem/feature

Description

Specific conditions for it to
be displayed/configured

Lock-in Count

For setting the number ("count") of oscillations (within
the preset "Detect[ion] Time") that will activate the
Lock-in

Only when Lock-in Usage is
"enabled"”

Lock-in Detect Time

For setting the length of the time interval within which
the Lock-in Count is conducted.

Only when Lock-in Usage is
"enabled"”

Lock-in Hold Time

Sets the duration for maintaining ("holding”) the Lock-
in Usage

Only when Lock-in Usage is
"Used"

Relay Configuration The six relays in the IDU are each associated with a None
parallel alarm. Four can be configured and the other
two (RLO1 and RL02) have fixed alarms.
Cluster 1 - 4 Input Allows the cluster alarm input to be enabled/ disabled. | None
EOW2 External Enables appropriate EOW?2 calling system signal None
Setting polarity to be set: "normal” when the NEO HP IDU is
connected to another NEO HP IDU or a PASOLINK
IDU; "invert" when connected to PASOLINK+ IDU or
Mx IDU
RX Level TCN For setting the threshold at which the TCN is displayed | None
Threshold

XPIC Condition-Local
Fail

For setting operation after Ref Local Alarm is issued

Only when XPIC Usage is
Used(Main Master), Used(Sub
Master)

SES Enables setting of the low threshold (%) that activates | None
Activation Condition SES
Alarm Correlation Allows the suppression of secondary (downstream) None

Capability

alarms to be turned on/off
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2.20.1 BER Threshold Setting
The BER thresholds throughout the system can be set in this window.

To change the BER threshold setting: B BER Threshold Settine
1. Select the BER threshold for each item.
2. Click the [Execute] button to apply changes.
3. Click the [Close] button when finished.

ilapulng]
EER Threshold Setting
High BER Threshald

@ 1E-3 (' 1E-4 () 1E-5

Liaowy BER Threshold

@ 1E-f (Y 1E-7 () 1E-8 ) 1E-d

E-BER(MLIX)
® 1E-3 (O 1E4 (U 1ES

SOMUX

W 1E-6 ) 1E-7 i) 1E-8 ) 1E9

E-BER(DMR)
@ 1E-3 (' 1E-4 () 1E-5

SDIDMR)

@) 1E-f (' 1E-7 () 1E-8 0 1E-8

Execute | | Close

2.20.2 SC Assignment

In this window, interface type (e.g. LAN, RS-232C, V11) that is available for user channels
(DSC) can be assigned and displayed. Setting the type of directional interface for SC3 and
SC4 is also possible.

SC Assienment

Mo.001
SC Assignment

SC1 SC2 | SC3 SC4 E1(MLIK) F1MUKD DCCrMLI) E1(DMR) F1(DMR) DCCHDMR)

RS-2320-1

RS-2320-2
-1
w112

S0 LA |

%11-1 Direction Setting %11-2 Direction Setting

(O] _Col-.dire-::tiqnal- ) Cortra-directional ®) Co-directional ) Contra-directional

Execute | | Cloge
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2.20.3 LAN Port Setting
Allows the LAN Port settings to be input or changed.

LAN Port Setting

Mo, 001
L&k Port SettinglGRE)
| Usage. I =
Wedia Type __]SFP | - |
Speed & Duplex |
Flawy Cortrol on b
{l Link Los=z Forvwarding ll|DisabIe | - |
LAM Part SettingrsUE)
Switc:hilr_ug_ lFundion _3|Disable | b |
Part1 Part2
: sage |Not Lzed - ] Uzage ._:|F_‘§1rét'_U§sd -

Speed & Duplex | Speed & Duplex |

Flawse Cortral

Link Losz Forwarding Link Loss Forswarding

| 1= |l .
| | | _ Florey Cortral |
Colision Report | ][ consonmeport |
ﬁ| =] |l ]

| Execute H Cloze |

Main (Work) - INTFC (1): GbE over STM-1/GbE over STM-1/300MB
SUB (PROT) - INTFC (2): WS/LAN WS/LANZ2

LAN Port Setting

fo. 00
LA Port Settingr SUE)
| swichngFuncton_|[isabe [~]
Piartd Part2
[ Usage E|Used | - | Usage :.f|Used | - |
Speed & Duplex §|AUTONEG(Amo-MD|MD|xJ | - | Speed & Duplex |AUTONEG(ALHD-MDIMDI}(J | - |
Flowe Control ?|On | - | Flowe Cortrol .f|On | - |
Collizion Repaort §|Repnr‘c | o | _ Collizion Report |Rep0r1 | v |
Link Loss Fu:-rwardin_g ;|Enable | o3 | Link Los= Fc-rwardir!g _f|EnabIe | b |
| Execute ‘ | Cloze ‘

Main (Work) - INTFC (1): STM-1 (Optical/Electrical)/2xSTM-1 (Optical/Electrical)
SUB (PROT) - INTFC (2): WS/LAN WS/LAN2
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2.20.4  ALS (Automatic Laser Shutdown)

When the ALS is enabled, the laser emission will be cut off after a e FHE P§|
certain period has elapsed after the IDU has issued an STM-1 = e -_| =
LOS. If the ALS is disabled, the laser emission will continue MO0
perpetually. ALS Funiction
To change the ALS settings: (@) Enable| ) Disable

1. Select Enable/Disable. ALZ Interval

2. Select ALS Interval. =

3. Click the [Execute] button to apply changes. | Execute | | Cloze |

4. Click the [Close] button when finished.

2.20.5 TX Power CTRL

The MTPC TX Power, ATPC Threshold Level, Additional ATT, ATPC Range as well as
Power mode can be set in this window.

To change the TX Power settings: B TX Power GTRL FEX
P00
1. Enter the desired value for each item in the TX ¥ Prer CTRL
POWGr CTRL fIEId' MTPC T Povneer 10| [¢B]
. ATPC Threshald Level -5| [dEm]
2. Select ATPC Power Mode. (if enabled) ackitiorl ATT ol e
3. Select COMM Alarm Mode. ATFC Range(ue) (]
ATPC Range(Ir) [tE]
4. Click the [Execute] button to apply changes. ATRC Fower o
(]
5. Click the [Close] button when finished. COMM Alarm Mode
®) Hold ) Mute
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2.20.6 SW Condition

In this window, the switching (SW) parameters can be set.

B s condition [ |[01/[X]

T 001

To change the switching parameters:

1. Select the Priority, Lock in Usage, and Reverse Function | T<sw

in the TX SW field. Priority
(® Mon Priarity o Priarity Ma.1
2. Select the Priority, Maintenance Mode and Condition-

Early Warning in the RX SW field.

Lock in Usage

3. Click the [Execute] button to apply changes.

Reverse Function

4. Click the [Close] button when finished. ® Used () Not Used

R =y
Priority
() Mon Priority 8 Priority Ma.1
Maintenance Mods
(® Marual ) Forced
Condition-Early VWarning
) Included B 8 Excluded v

Cloze

2.20.7 SW Condition (APS)
In this window, the switching (SW) parameters for APS can be set.

To change the switching parameters:

B SW Condition{APS) Al=1.1

1. Select the desired setting in the Maintenance

Mode, Condition-SF, Condition-Signal ae HloHt
Degrade and LOCk in Usage fleld Mairtenance Mode
2. Enter the desired value for Lock in Count, Lock @ Manual ) Forced

in Detect Time and Lock in Hold Time field. Condition-SF
) Priority High o Priarity Loy

3. Click the [Execute] button to apply changes.

Condition-Signal Degrace
4. Click the [Close] button when finished. ® includedt 5D ) Excluded SD

Lock in Usage
) Used @) pot Used

Lock in Cournt

[tirmes]

Lock in Detect Titme

[rmim]

Lock in Hold Time

[hours]

Cloze
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2.20.8 Relay Configuration

This window shows the six relays in the IDU (that are each associated with a parallel alarm).
Four can be configured and the other two (RLO1 and RLO2) have fixed alarms.

Relay Gonfiguration

Moo
Relay Configurstion

FLOA FLOZ RLOS FLO4 RLOS RLOG
Hk QLT -

Hi< OUIT2
Hi LT3
Hi< oLIT4
CLUSTER ALM OUT1
CLUSTER LM OLIT2 Lo
CLUSTER ALM OUT3
CLUSTER LM OLIT4
P& INT Out o ask Il aske o azk il ash
0L CPL ALM Dut
FS ALM (M) Dut
PS ALM (Mo 2) Dut
oD ALM (Na.1) —]
DL ALM (No.2)
ODU CPU ALM (Ma 1)
DU CPU ALM (Mo 2)
Ti PR ALM (Na.1)
Ti PR ALM (No.2)
T NPT ALM ho 1)
T NPT &LM R0 2)
APC AL (a1
4PC ALN (hlo.2)
R LEVEL ALM (No.1)
R LEWEL ALM (hio 2)

1

Execute | | Close

2.20.9 Cluster Alarm Input

Cluster alarms can be enabled/disabled with this

Gluster Alarm Input

window.
. Fo 001
To change the Cluster Alarm Input settings: Cluster! Inpul
1. Select Enable/Disable in the Cluster1~4 Input () Enable (@) Dizable
field.
Cluster? Input
2. Click the [Execute] button to apply changes. ® Enable () Disable
3. Click the [Close] button when finished. Cluster3 Input

(®) Enable () Dizable
Clusterd Input
() Enable ® Dizable

Execite | ‘ Cloze
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2.20.10 EOW?2 External Setting
The EOW?2 calling system signal polarity can be set here.

To change the EOW?2 External settings:

EOW2 External Setting |Z|l§|le

1. Select Normal when the NEO HP IDU is
connected to another NEO HP IDU or o001
PASOLINK IDU. ECy2 External Setting
2. Select Invert when the NEO HP IDU is ® Normal J Invert
connected to PASOLINK+ IDU or Mx IDU.
. Execute | | Clozse
3. Click the [Execute] button to apply change.

4. Click the [Close] button when finished.

2.20.11 PMON Select
The RX Level TCN Threshold and SES Activation percentage can be set.
To change the PMON Select settings:
1. Enter the desired RX Level TCN Threshold value in the No.1 and No.2 field.
2. Select the SES Activation Condition percentage.
3. Click the [Execute] button to apply changes.
4. Click the [Close] button when finished.

PMON Select =13
Mo 00

a1 o2

Fx Level TCH Threshold 0.0] [dBEm] R Level TCH Threshald 0.0| [dEm]

SES Activation Condition

@) 150%] ) 30[%]

| Execute || Close

2.20.12 Alarm Correlation Capability
In this window the suppression of secondary (downstream) alarms can be turned on/off.

To change the alarm correlation capability:

Alarm Correlation Capability |Z||§|E|

1. Select On/Off depending on desired
State. M 001

2. Click the [Execute] button to apply Pl e ATl el

change. won O of
3. Click the [Close] button when EN—. || Close
finished.
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2.20.13 XPIC Condition — Local Fail

For setting operation after Ref Local Alarm is issued; the setting is switched from Ref LO to
Self LO.

To change the XPIC Condition — Local Fail

1. To switch operation of ODU from Lo —
synchronization to self synchronization, [ EdpeRer TR v I W l[S)( 3
select [RefLo=>SelfL0].

Mo 001

2. To set mute and stop transmission, WPIC Condition-Locsl Fai

select [Mute]. (W) REF LO-=Self LO. L Mute

3. Click the [Execute] button to apply
change. Execute || Cloze

4. Click the [Close] button when finished.
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2.21 Link Performance Monitor

The following performance-related items can be monitored according to G.826
recommendation:

0 Out of Frame Second (OFS) — the total number of seconds the "out of frame"
condition is generated in 15 minute-blocks. (OFS is applied to the Total only)"

0 Severely Errored Period (SEP) — the cumulative time in which the BER of a
one-second period exceeded 10E-3.

o Background Block Error (BBE) - the sum of the B1 background block error

o Errored Second (ES) — the cumulative time in which more than one B1 error
pulse per second was detected

0 Severely Errored Second (SES) — the cumulative time in which the BER of a
one-second period exceeded a set percentage (15% or 30%).

0 Unavailable Second (UAS) —the cumulative time in which the unit remained
inoperative

0 RX Level monitors —the minimum and maximum reception level (when there
are two routes it does so for No. 1 and 2 respectively

Pink color in Performance Monitor window indicates that the threshold value has been
exceeded. The threshold values can be set in Threshold window. The detailed daily
performance data for the last seven days can be viewed by clicking the [Detail] button.

2.21.1 Viewing Summary Link Performance Monitor
To view Summary Link Performance Monitor:

Click Performance Monitor - Link Performance Monitor in the NE-specific menu bar of
the target NE that you intend to monitor (or alternatively PNMT window—> LPM).

You can delete the target NE's PMON/RMON data by selecting the [All Data Clear] and
clicking [Execute].

& Link Performance Monitor — No. 001

List

Detail Thirezhold
Latest 15 min 1 day
15 min 1 day Ccour Recover Cicour Recover
CFS b s 200! F44) 1 1
[=EP 4 e 700 544/ 0 0
EEE 4 & E00 G001 0 0
ES b s 700! F44, 0 o]
SES b 22 E44 Fd4) 0 0
AS 4 e E44 544/ 0 0
X LEV IR 100[ciEm] S0[ciEm] 1
W LEVIMAX) 1000[cBm] S00[ciEm] |
DR

Summary Link Performance Monitor window
In the case of SDH STM-1 with APS, the tabs on the bottom of the LPM window, allow MUX

(W), MUX (P), DMR (W), DMR (P) to be selected, without APS, MUX and DMR can be
selected.
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2.21.2 Threshold Setting

To set the threshold values:

1. Click [Threshold] button in the Summary Link Performance Monitor window.

CEX

B Link Performance Monitor Threshold[DMR]

P 00
Set Threshald
13 min 1 day
Qcour Recover Ocour Recover
OF= Qa0 a0 559354 G50
SEF a00 a0 53334 §50
BEE G5534 G50 65534 §50
ES 00 a0 G59354 G50
SES Qa0 a0 559354 G50
Uas a00 a0 53334 §50
Execute | ‘ Cloze

Summary Link Performance Monitor Threshold

Select the performance-related items that are to be configured in the table shown

above. The G.826 measure becomes available for setting when selected.

Set the monitoring values (the alarm Occur and Recover) in the appropriate field.
The alarm status will be monitored when it reaches the alarm occur value and issue
an alarm clear status when the recover value set in the threshold table is reached.

Click [Execute] button to activate the new settings.

Click [Close] button when finished.
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2.21.3 Link Performance Monitor (1day / 15 min. Data) window
To view the 1day Data:

1. Click [Detail] button in Summary Link Performance Monitor window.

@ Link Performance Monitor [Daily DMR datal — No.001

File  Wigwy
OFs ZEF EEE Ex ZE= uaz R LEW (IR R LEW 1 (M2 R LEY2(MIN ] R LEW2(M2 X

01/200/2009

0118/2003 112 113 114 114 116 117 -140 -15.0 -16.0 -170
011552009 118 118 120 121 122 123 -18.0 -19.0 -20.0 -21.0
01172003 124 #1235 126 127 *128 129 *-x2n £-230 *-240 250
11652009 *130 =131 *132 133 * 134 135 *-260 F-270 *-2E50 £-290
011552003 136 137 138 138 140 14 =300 -31.0 -32.0 =330
011 452003 142 143 144 145 146 147 =340 -3a.0 -36.0 -37 0
01152009 145 148 150 151 152 1535 <330 -39.0 -40.0 -41.0

Feady File Zize: 1246 Bytes |

Link Performance Monitor (1 day Data) window

To view the 15-min. Data:

1. Click button of the target date in Link Performance Monitor (Daily Data) window to
display the detailed 15-minute performance data.

@ Link Performance Monitor [15-min DMR datal — No.001

File  “iews
%
Date | 1 H9/2003
OF S SEP EEE ES SES UAS | RILEVI(MING | RXLEWAMAX) | RXLEVIMM) || RXLEVZ(MAX) |
345.14:00 4456 4469 4472( 4475 4478 44w 1940 1960 A95.0 —200.0( = |
4001415 4484 * 4487 +4490  *4493  * 4495 * 4499 2020 +204.0 * 2060 * 2080
415.14:30 4502 4505 4508 4511 4514|4517 2100 2120 2140 2160
4:30-14:45 4520 *4523 +4526  *4529)  +4537 4535 2180 + 2200 *+ 2221 *+ 22410
4451500 4538 4541 4544 4547 4880 4553 2260 2280 2300 2320
S00-1515 4556 4559 4sg2) 4565 4588 457 2340 236.0 2380 2400
S15.1530 4574 4577 4580 4533 488 4589 2420 2440 2450 2430 |
5301545  *4592)  *4595 +4508  *4G0M|  *4B04) 4607 * 28500 + 2520 * 2540 e
S5 1800 4810 4613 4618 4819)  4e22)  4E25 20 40 &0 a0
GO0 1615 4628  * 4631 *4F34 * 4637 46400 * 4643 +.10.0 * 120 + 4.0 * B0
B15-16:30 4848 4549 4p52( 4655 4msE 4661 80 200 220 240
G:30- 1645 4664|4667 4670( 4673 4678 4679 260 28,0 300 -32.0(+|
Ready File Size: 13155 Bytes | |

Link Performance Monitor (15-min. Data) window

2. The data can be saved in text format by clicking on the save icon. Or it can be
refreshed by clicking on the reload (refresh) icon.

WARNING!!!

While data is being updated, do not remove the USB cable
connecting the IDU with the PC.
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2.22 Remote Network Monitoring (RMON)

Remote Network Monitoring (RMON) function can monitor the signal through the LAN port,
both LINE-side (the port on the NE) and DMR side. RMON can count the number of received
or transmitted packets and packets errors. These items are then displayed in the PNMT.

The following RMON items can be monitored:

RMON RX Unicast Pkts — the total number of unicast packets received. This item
measures from 64 octets to 1536 octets.

RX Broadcast Pkts — the total number of packets received that were directed
to the broadcast address. This item measures from 64 to 1536 octets in length.

RX Multicast Pkts — the total number of packets received that were directed to
a multicast address. This item measures from 64 to 1536 octets in length.

RX Pause Pkts — the total number of packets received that were paused.

RX CRC Errors — the total number of packets received that detected FCS
error. This item measures from 64 to 1536 octets in length.

RX Align Errors — the total number of packets received that detected
Alignment error. This item measures from 64 to 1536 octets in length.

RX Symbol Errors — the total number of packets received that detected
Symbol error. This item measures from 64 to 1536 octets in length.

RX Undersize Pkts — the total number of good packets received that were
less than 64 octets in length.

RX Fragments — the total number of packets (Including bad packets) received
that were less than 64 octets in length.

RX Pkts 64 — the total number of packets (Including bad packets) received that
were 64 octets in length.

RX Pkts 65-127 — the total number of packets (Including bad packets)
received that were between 65 and 127 octets in length.

RX Pkts 128-255 — the total number of packets (Including bad packets)
received that were between 128 and 255 octets in length.

RX Pkts 256-511 — the total number of packets (Including bad packets)
received that were between 256 and 511 octets in length.

RX Pkts 512-1023 — the total number of packets (Including bad packets)
received that were between 512 and 1023 octets in length.

RX Pkts 1024-1536 — the total number of packets (Including bad packets)
received that were between 1024 and 1536 octets in length.

RX Pkts 1537-MAX — the total number of good packets received that were
between 1537 and 1916 octets in length.

RX Jabbers — the total number of packets received (Including bad packets)
that were longer than 1537 octets.

TX Unicast Pkts — the total number of unicast packets transmitted. This item
measures from 64 to 1916 octets in length.

TX Broadcast Pkts — the total number of packets transmitted that were
directed to the broadcast address. This item measures from 64 to 1916 octets
in length.

TX Multicast Pkts — the total number of packets transmitted that were directed
to a multicast address. This item measures from 64 to 1916 octets in length.

TX Pause Pkts — the total number of packets transmitted that were paused.
TX Total Collisions — the total number of collisions when it is transmitting.
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NOTE:

If an item causes overflow,”+” will be shown in front of
the number.

If an item is invalid, “*” will be shown in front of the
number. When the total number is incomplete, it will be
shown as invalid.

During maintenance mode, an item will be highlighted in
the maintenance color (yellow as default).

2.22.1 Viewing LAN INTFC RMON [Current]

This window contains the latest 15-minute data (15-min) and to the current day’s total data
(Daily) for all RMON items.

To view RMON LAN INTFC [Current] Monitor:

Select Performance Monitor > LAN INTFC RMON [Current] in the NE-specific menu bar
of the target NE that you intend to monitor.

You can delete the target NE's PMON/RMON data by selecting the [All Data Clear] and
clicking [Execute].

© LAN INTFG RMONICurrent] - No.001 =13

Pott1 (Main) LINE Part1(fain) DR Port2(hzin) LINE Part2(Main) DR
15-min Doaily 1 S-tin Daily 1 5-tin Daily 1 5-tin Daily
a1 17 97
32 18 93
g3 19 99
24) 20 100
35 21 101
22
23
24
25
26
27

R Unicast Pkts
Fx Broadcast Pkis
R muticast Pkts
X Pause Ptz

Fx CRC Errors

R Align Errors
RN Symibol Errors
R Unclersize Phts
FX Fragments

— O oo =4 = e [ | —

==

FX Pkiz B3-127

LAN INTFC RMON [Current] window

This data can be refreshed by selecting List > Refresh menu or clicking on Refresh
icon.
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When WS/LAN is set in SUB (PROT) - INTFC (2), Port x (Main) and Port x (SUB) will be
separately displayed

& LAN INTFG RMON[Current] - Mo 001

=13

I Port1 (Main) LIME | Port1 (Main) DR | Port20Mair) LINE | Port2(Main) DMR | Port1(SUB) LINE | Port1 (SUB) DMR | Port2(SUB) LINE | Port2(SUE) DMR:
15-min | Daily | 15-min | Daily | 15-min | Daily | 15-min | Daily [ 159-min | Daily | 15-min | Daily | 15-min | Daily | 15-min | Daily
IR Linicast Phts 1 257 a1 353 17 2389 47| *369 33 *305 113 *385 49f  *32
R Broadcast Phts 2 258 52 354 18 290 *ag| #5370 34f  *306 114]  *386 500  *322
IR Mutticast Prts 3 259 83 355 19 291 *9q  *371 35)  *307 115  *387 51 *323
ﬁ)( PaLise Pkis 4 260 54 356 20 292  *oo) =372 36)  *308 116]  *388 52| raz24f
W CRC Errors 5 261 85 357 21 293 Mo *3T3 37| *309 117]  *389 53] *325
IR &lign Errors E 262 22 294 380 *30 S54f  *326
ﬁ)( Symhol Errors 7| 263 23] 293 390 31 550  *327|
W Undersize Pris 5 264 24 296 40 =312 56! =328
IR Fragments: g 265 39 361 25 297 05| *377 41 313 121 #3903 57]  *329
IR Pits B4 10 266 a0 362 26 298]  *MOE| =378 420 =34 122 *394 58 *330
ﬁ)( Ptz 65-127 11 267 91 443 27 293 07| *379 43 *35 123 *395 590 *33
W PRts 128-255 12 268 92 444 28 300 *1 08 =350 44 =316 124 =396/ =10 *332
IR Phts 256-511 13 269 93 445 29 301 03] *331 450 =37 125  *397 81 333
IR Prts 512-1023 14 270 94 445 30 3020 *10] =382 46  *38 126 *398 62)  *334)
ﬁ)( Ptz 1024-1536 15 271 95 447 31 3030 11 383 47 =319 127 *399 63f  *335
W Phts 1537 -Max 16 272 95 368 32 304 M12]  *384 48] *320 125  *400 G4f  *336
IR Jabbers 17 273 97 363 33 3050 M13| #5385 49)  *32 128)  #401 B5[  *337
T Unicast Pkts 18 274 93 370 34 3060  *114]  *386 s0f =322 1300 *402 B6f  *335
E)( Broaccast Prts 19 275 99 371 35 3070 15| *387 51 *323 131 403 67)  *339
W Wutticast Pkis 20 276 100 372 36 3080 16| *388 52)  *324 132]  *404 B&[  *340
T Pause Pits 21 277 10 373 37 3090 *M17| =389 53] *325 133] #4055 BIj  *341
X Total Collisions 22) 278 35 30 54  *326 0 Y

2.22.2 Viewing LAN INTFC RMON [15-min]

This window contains the total 15-minute data (for 24 hours) for all RMON items.
To view LAN INTFC RMON [15-min] Monitor:

1. Select Performance Monitor - LAN INTFC RMON [15-min] in the NE-specific
menu bar of the target NE that you intend to monitor.

RMOMN [15-min Datal - No. 001
Select  Sort

B=1E3

File

Part1 (hdain) LIME
R Unicast Pkiz R Broadcast Ptz R hulticast Pkis

01202009 00:00-00:15 g 9 10

01,20/2009 00:1:5-00:30 154 183 186 =
012002009 00:30-00:43 360 361 362

012002009 00:45-01:00 *536 *537 *535

01202009 01:00-01:15 712 T3 714

012002009 01:1:5-01:30 *BET *B59 =590

012002009 01:30-01:43 1064 1065 1066

012002009 01 :45-02:00 1240 1241 1242

012002009 02:00-02:15 1HE 14M7 1418

1] [*]
File Size: 214429 Bytes I

LAN INTFC RMON [15-min] window

2. This data can be saved by selecting File > Save All Data menu or clicking on Save
All Data & icon. The default file name that it will be saved to is “15min.rmon”.
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3. This data can be refreshed by selecting File > Reload menu or clicking on Reload

%

icon.

4. This data can be sorted by port or Iltem by selecting Sort - Port Sort or Item Sort
menu.

5. The viewing RMON items can be selected with the Select window.

If a WS/LAN or WS/LAN2 is set in the SUB (PROT) - INTFC (2), Port x (Main) and Port x
(SUB) will be displayed separately.

WARNING!!!

While data is being updated, do not remove the USB
cable connecting the IDU with the PC.

To view the Select window:

1. Choose Select > Select menu.

RMOH Select[15-min Datal

Select kem

LINE DMR
Pott |wlport2  |w|portt  |wport2 |

I ftem

01 [FX Unicast Pkis
02 [FX Broadcast Pkis
03 |RX Multicast Pkts
04 |FX Pause Ptz

03 [FX CRC Errars

068 [FX Align Errors
07 [F¥ Symbal Errors
03 Rk Undersize Pkts
09 [FX Fragmerts

10 |FX Pkiz 64

11 |F¥ Phis 65127
12 [R¥ Ptz 128-255
13 [F¥ Pkts 256-511
14 |Fx Ptz 512-1023
15 [FX Pktz 1024-1536
16 [R¥ Ptz 1537 -Max
17 [FX Jabbers

18 [T Unicast Pkis
19 ||[Tx Broadcast Pkts
20 ||t Mutticast Phts
21 [T¥ Pause Ptz

22 [T Total Coligions

ElEEIEEENEE )R RpEE) RS
EENEGE|E R EIEE)E) R E R E )RR

LENEIE|EE)EIE)E)E) RSSO E S S S
CENEGEE R EE) ) E R R R R ]

Cancel

LAN INTFC RMON [15-min] Select window
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You can select/deselect the items that you wish to view by clicking the list [¥] icon and
selecting from the pull down menu {Select All / Clear All}, Package control of all items can be
carried out for individual Port.

2.22.3 Viewing LAN INTFC RMON [Daily]
This window contains the daily data in 7 days for all RMON items.
To view RMON LAN INTFC [Daily] Monitor:

1. Select Performance Monitor > LAN INTFC RMON [Daily] in the NE-specific menu
bar of the target NE that you intend to monitor.

ir RMOHN [Daily Datal - Ho.D0O1
File Select Sort

| =

Part1 LIME

R Unicast Pktz R Broadcast Pkts R Mutticast Pkts
01/20/2009 g 9 10

011972009
01M&8/2009
01 M 72009
01ME/2009
01152009
01M4/2009

File Size: 8360 Bytes | |

LAN INTEC RMON [Daily] window

2. This data can be saved for all items by selecting File > Save All Data menu or
clicking on Save All Data =l icon. The default file name is “daily.rmon”.

3. This data can be refreshed by selecting File - Reload menu or clicking on Reload

e icon.

4. This data can be sorted by port or Iltem by selecting Sort - Port Sort or Item Sort
menu.

5. The viewing RMON items can be selected with the Select window.

If a WS/LAN or WS/LAN2 is set in the SUB (PROT) - INTFC (2), Port x (Main) and Port x
(SUB) will be separately displayed.
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To view the Select window:

Go to Select - Select menu.

RMON Select[15-min Datal

Select tem

(Main)LINE (SUBJLINE (Main)DMR (SUBICMR
Fort!  |wlportz  [wlPortt  [wlportz  [wlPot1  [wlportz  [wlpott  [wlpotz |

In] fterm

01 |RFX Unicast Pkis
02 |F¥ Broadoast Pkis
03 |Fx Multicast Pkis
04 |F¥ Pause Pkis

05 |Fx CRC Errars

06 | Align Errors

07 FX Symbal Errars
05 |RX Undersize Pits
09 |RX Fragments

10 X Phi=s 64

11 |F¥ Pht= 65-127

12 |RX Pht= 128-255
13 |F¥ Phts 256-311
14 | Phtz 512-1023
15 |R¥ Pkt= 1024-1536
16 ¥ Phts 1537-Max
17 |PX Jabbers

18 (T Unicast Pkis
19 |(TX Broadcast Pkis
20 T hulticast Pkts
21 |[TX Pause Ptz

22 |[TX Total Callisions

RN EE RG] EE )RS R
EENEEE) =) E R RS E RS E R R R
L T I T T I g
I I T T T I I I T T IR e
CENE = ER )R E R E S = O =
I (8] 158 G881 1R8] (A8 (S A8 10 G681 1A [, e (A9 18 668 3] 1A
I I T T T I I I T T IR e
L T I T T I g

Cancel

LAN INTFC RMON [Daily] Select window

You can select/deselect the items that you want to be shown by clicking on the list [¥] button
and selecting from the pull-down menu {Select All / Clear All}. Package control of all items
can be carried out for individual port.
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2.23 Event Log

The Event Log window displays the date/time when the event data was received, item, and
status.

2.23.1 Event Log monitor

1. Click [Event Log] in the NE-specific menu bar of the target NE that you intend to
monitor.

2. A message window showing the progress of the uploading of the Event Log data will
appear on the screen. Wait until the PNMT finishes the uploading of the data. The
progress window will automatically close once the uploading is completed.

3. The Event Log View will be displayed. The event log is presented in a table form
showing the date of the event, the item that triggered the event and the status
change.

4. Sorting is possible for every column in the Event Log window.
5. The date shown in the Event Log window will be in the format of the OS.

6. The data can be refreshed by clicking on the upload (refresh) icon.

WARNING!!!

While data is being updated, do not remove the USB
cable connecting the IDU with the PC.

B NE Stored Log — Ho 001

File
A==

DiatedTime Metweork Element

Feady Total Events: 9235 File Size: 93425 Bytes I
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2.24 Inventory Tab

The relevant inventory information for the equipment can be viewed using this function.

2.24.1  Inventory Monitor
To display the equipment version:
1. Click the respective Inventory field in the PNMT main window of the target NE.

2. The Inventory window shows the Code No., Date of Manufacture, Serial No.,
Hardware Type and Software Version of the equipment.

. Detail - No. 0D1

Categary ftem Status
Commaon 00U Coe hlo. i
Camiman 00U Package Mame i
Commaon 0D Serial Mo i
Comman 0D Date of Manufacture
Common ODU Hiw Yersion
Comman DU Fiy ersion
Common ODEM Code Ma.
Common WMODEM Package hame
Commaon ODEM Serial Mo.
Comithon WODEM Date of Manufacture ]
apL J MODEM J ATNOAORIC) J SUBPROT) | ALK I CTRL | |nventory
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Appendix A: Equipment Network Settings (Terminal)

In Equipment Network Setting, a variety of items can be set individually for each NE.
Depending on NE, CTRL Type can also be selected (CTRL or Branch NE).

CTRL Type (General) Category Input Item
CTRL Type Branch NE Type
General CTRL Type
Branch NE Type
Radio/EM?2 IP Address
Subnet Mask
EML IP Address
Root NE Not selectable Subnet Mask
PNMS IP Address
V1l Subnet Mask
Speed
Routing Defa-Lu It Gat.eway
Static Routing Table
Equipment Type
General CTRL Type
Root NE Branch NE Type
00
8 Not selectable
(Bridge) Radio/ EM1/EM2 IP Address
Subnet Mask
Routing Defa_lult Gat.eway
Static Routing Table
General CTRL Type
Branch NE Type
Radio Esddri/'ls.s ”
2 Branch - r(;zt as
EML/EM2 IP Address
Subnet Mask
Routing Defa_lult Gat.eway
Static Routing Table
Branch NE General CTRL Type
Branch NE Type
Radio IP Address
Subnet Mask
3 Branch EM1 IP Address
Subnet Mask
EM?2 IP Address
Subnet Mask
Routing Defa.LuIt Ga'feway
Static Routing Table
General CTRL Type
Branch NE Type
Normal NE Not selectable Radio/EM1/EM2 IP Address
Subnet Mask
Routing Defa_lu It Gat.eway
Static Routing Table

Note: Here EM1 / EM2 indicate IDUs front interface NMS/ NE ports respectively
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1. In Category > General and select CTRL Type (CTRL Type and Branch NE Type)

Equipment Hetwork Setting

Mo .001
General General
|- Radin |
Femzem | Sl
Routing Ecjuipmernt Type: |
f CTRL Type
CTRL Type: |Eiran|:h ME
Rort
Category Eranch ME Type: |2 branches
Category Part Infarmation
Port | P address | Subrnet Mask
Fadio 0.0.0.0 255255255192
ErZER1 0.0.0.0 235295295192
1
Execute | | Cloze

The NE will appear as follows according to configuration.

e Root NE

The nearest NE to PNMS configure as Root NE

¢ Root NE (Bridge)

The nearest NE to PNMS configure as Root NE(Bridge)

(One IP Address is assigned to Root NE(Bridge), and Subnet is not divided.)

e Branch NE (2 Branch)

Subnet diverges in two ways

e Branch NE (3 Branch)

Subnet diverges in three ways

e Normal NE

All other NEs (except the above-mentioned) are simply referred to as Normal NEs.
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2. The Port Category item changes according to CTRL Type (CTRL Type and

Branch NE Type).

beneral|
FeacliciEf 2
PHMECERT )
Rowting

Port
Category

General

System

ipment Type:

CTRL Type

CTRL Type:

Branch ME Type:

General

FadioEh1 JEMZ
ISR ) N

General
System
Eciigugert Type:
CTEL Type

CTRL Type:

Eranch ME Type:

|Root rE

CTRL Type = Root NE

CTRL Type = Root NE(Bridge)

Zeneral
Fadio
Ehd2/ER
Routing

General

\ System

uipment Type:

CTRL Type

CTRL Type:

Eranch ME Type:

| |~
| -]
Roct NE(Eridge) [v]
| 4
| -]
|Eiranch ME |v|
|2 hranches | - |

CTRL Type = Branch NE or Branch NE Type = 2 Braches

General
Radio
EM1 \
Em2
Fouting

General
System

ipment Type:

CTRL Type

CTRL Type:

Branch ME Type:

Zeneral

RadicEhd JEMZ

General

System

CTRL Type

CTRL Type:

Eranch ME Type:

|Eiranch ME

A

|3 branches

A

CTRL Type = Branch NE or Branch NE Type = 3 Branches

|N0rmal ME

[~

CTRL Type = Normal NE
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3. Set and select Port category and Routing. The right hand screen will change
according to the selected item in Category.

e Primary IP Address

PNMS identify a NE with using the IP address in NE. The check can be applied only
to lport category of several Port categories that exists in CTRL Type when

Branch NE is selected.

e |P Address & Subnet Mask

The following items are set to each Port

[ Frimary IP &ddress

PrbZ Connection: |LAN | - |

L&

P Address: 0.0.0.0

=ubnet Mask: 255 255 255192
PNMS (EM1)

LAl

P Address: |1 021681253 |

Subnet Mask: |255.255.255.D |

Speed: 119200 v
PNMS (V11)

Primary [P &ddress

Metwwork

P Address: 0.0.0.0

Subnet Mask: 255255255192

Radio or EM1 or EM2 or EM1/EM2

Primary [P &ddress

Metwwork
P Acdress: 17218002
Subnet Mask: 255255255192
Radio/EM2

Primary [P &ddrezs

Metwwork

P Address: 0.0.0.0

=ubnet Mask: 255 255 255192

Radio/EM1/EM2
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4. Select and set Routing.

4-1 If there is not subnet in the network, Static Routing table will not show any
entries.

Default Gateway

P Address: 0000
Static Raowting Takle
IP Address | Subnetilaszk | Gateway
| A | | Moclify | | Remove |

4-2 In case of several subnet in the Network click [add] to entry the required value in
Static Routing Table

Default Gateway
P Address: In.0.0.0]

Static Rowting Table
P Address | Subnethiazk | Gateway

Gateway Address

P Address : 721901
Subnet Mask : 255 255,255 0
Gatenway : [172.19.0.254

Ok || Cancel |
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5. Click [OK] button to activate the address setting.

Equipment Hetwork Setting |_'_ ||I:||[$_(|
Moo
General Routing
Fezcio/EM1 Eh2
Routing Detfault Gateweay
P Address: D000
Static Routing Table
IP Address | Subnethdazk Gateweay
172.19.01 2552552550 172.19.0.254
‘ Add | | hadify ‘ | Remaove |
I
Execute ‘ | Cloze |

[Modify] is clicked to correct the registered value in Static Routing table.

[Remove] is clicked to delete the registered value in Static Routing table.

6. Click [Execute] button to activate the Equipment Networking setting.

NOTE:

When configuring Equipment Network Setting,
communication will be lost when the Control module
reinitializes to the new system configuration. This WILL
NOT affect the wireless link. During this time PNMT
connection to the NE will be disrupted but will
automatically be restored after the Control module resets.
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Appendix B: Sample Network Configuration

1. The Network Configuration when subnet is connected.

192.168.0.10
255.255.255.0

172.18.0.1

’
7

,”255'255'255'192

’ ( 1 No.02 No.03 ( 1 No.04
P L)
_— Normal NE Normal NE Normal NE
Router —
' 172.18.0.2 172.18.0.3 172.18.0.4
192.168.0.1 255.255.255.192 255.255.255.192 255.255.255.192

255.255.255.0

PNMT i:

General (Category)
NE Category Item Name Input data
CTRL Type Branch NE
Type
) IP Address 172.18.0.1
Radio/EM2
Subnet Mask 255.255.255.192
Not IP Address 192.168.0.10
No.01 | Root NE | | PNMS (EM1)
selectable Subnet Mask 255.255.255.0
. Default Gateway 192.168.0.1
Routing
Static Routing Table -
_ IP Address 172.18.0.2
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.02 | Normal NE | bl
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
) IP Address 172.18.0.3
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No0.03 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
) IP Address 172.18.0.4
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.04 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
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2. The Network configuration in case of several subnets

(Branch NE Type = 2 Branches)

192.168.0.10
255.255.255.0

192.168.0.1
255.255.255.0

172.18.0.1

255.255.255.192

172.18.0.3
255.255.255.192

ROI-S07052

( 1 N0.02 1 No.04{ \
“““Normal NE  BranchNE AN ormal NE
172.18.0.2 172.18.0.65 172.18.0.66

255.255.255.192

255.255.25-5.192

255.255.255.192

General (Category)
NE [ cTRL Branch NE Category Item Name Input data
Type Type
) IP Address 172.18.0.1
Radio/EM2
Subnet Mask 255.255.255.192
IP Address 192.168.0.10
Not PIMS (EM1) Subnet Mask 255.255.255.0
No.01 | Root NE selectable ubnet Mas . . .
Default Gateway 192.168.0.1
Routing IP Address 172.18.0.64
Static Routing Table | Subnet Mask 255.255.255.192
Default Gateway  172.18.0.3
_ IP Address 172.18.0.2
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No0.02 | Normal NE
selectable , Default Gateway 172.18.0.1
Routing
Static Routing Table | -
) IP Address 172.18.0.65
Radio
Subnet Mask 255.255.255.192
IP Address 172.18.0.3
No0.03 | Branch NE 2 Branches EM1/EM2
Subnet Mask 255.255.255.192
Default Gateway 172.18.0.1
Routing
Static Routing Table | -
) IP Address 172.18.0.66
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No0.04 | Normal NE
selectable , Default Gateway 172.18.0.65
Routing
Static Routing Table | -
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3. The Network configuration in case of several subnets

(Branch NE Type = 3 Branches)

192.168.0.10
255.255.255.0

172.18.0.1
255.255.255.192

172.18.0.3
Rl 255.255.255.192

ROI-S07052

172.18.0.65
255.255.25-5.192

No.02 ——= | No.o4f ™
________ Jo-- N -
_____________ , L -
Normal NE | ranch NE Normal NE
172.18.0.2 EM2 172.18.0.66
172.18.0.129

255.255.255.192

192.168.0.1
255.255.255.0

1
1
:
255.255.255.192:
1

255.255.255.192

1

1

No.05 ( 1 No.06| |
/:ft __________ L___J ____________ :
Normal NE Normal NE
172.18.0.130 172.18.0.131

255.255.255.192

255.255.255.192

General (Category)
NE [ cTRL Branch NE Category Item Name Input data
Type Type
. IP Address 172.18.0.1
Radio/EM2
Subnet Mask 255.255.255.192
IP Address 192.168.0.10
PNMS (EM1)
Subnet Mask 255.255.255.0
No.O1 | Root NE sN(;)IE-:-ctable Default Gateway 192.168.0.1
IP Address 172.18.0.64
Subnet Mask 255.255.255.192
Routing . i Default Gateway  172.18.0.3
Static Routing Tabl
alic Roufing 1ab%€ "I Address 172.18.0.128
Subnet Mask 255.255.255.192
Default Gateway 172.18.0.3
_ IP Address 172.18.0.2
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.02 | Normal NE
selectable , Default Gateway 172.18.0.1
Routing
Static Routing Table | -
) IP Address 172.18.0.65
Radio
Subnet Mask 255.255.255.192
IP Address 172.18.0.3
EM1
Subnet Mask 255.255.255.192
No0.03 | Branch NE 3 Branches
EM2 IP Address 172.18.0.129
Subnet Mask 255.255.255.192
Default Gateway 172.18.0.1
Routing
Static Routing Table | -
) IP Address 172.18.0.66
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.04 | Normal NE
selectable ) Default Gateway 172.18.0.65
Routing
Static Routing Table | -
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General (Category)
NE | CcTRL Branch NE Category Item Name Input data
Type Type
. IP Address 172.18.0.130
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.05 | Normal NE
selectable ) Default Gateway 172.18.0.129
Routing - -
Static Routing Table | -
IP Address 172.18.0.131
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No0.06 | Normal NE | bl
selectable Default Gateway | 172.18.0.129
Routing
Static Routing Table | -
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4. The Network Configuration when subnet is connected.

Router

il

; — No.01
PNMS /7~~~
! Root NE
172.18.0.1 (Bridge)
255.255.255.192
172.18.0.2

(CTRL Type = Root NE(Bridge))

172.18.0.1
255.255.255.192

255.255.255.192

f 1 No.02
L)

Normal NE

172.18.0.3

255.255.255.192

255.255.255.192

Normal NE

172.18.0.4

255.255.255.192

ROI-S07052

Normal NE

172.18.0.5

-y No.01 ( 1 No.02 No.03
Root NE “Normal NE =~ "Normal NE
(Gl 172.18.0.3 172.18.0.4

172.18.0.2 255.255.255.192 255.255.255.192

255.255.255.192

Normal NE

172.18.0.5

255.255.255.192

General (Category)
NE Category Item Name Input data
CTRL Type Branch NE
Type
. IP Address 172.18.0.2
Radio/EM1/EM2
No.01 Root NE Not Subnet Mask 255.255.255.192
(Bridge) selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
_ IP Address 172.18.0.3
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.02 | Normal NE | bl
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
_ IP Address 172.18.0.4
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No0.03 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
) IP Address 172.18.0.5
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.04 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
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5. The Network Configuration when subnet is connected.

(PNMS Connection: V11)

192.168.0.10
255.255.255.0

172.18.0.1
I,’255.255.255.192

Normal NE

172.18.0.2
255.255.255.192

172.18.0.3

192.168.0.1
255.255.255.0

PNMT

3

*V11 connection is available with only the top equipment.
Other equipment is connected through LAN.

Normal NE

255.255.255.1

e

ROI-S07052

172.18.0.4

General (Category)
NE Category Item Name Input data
CTRL Type Branch NE
Type
) IP Address 172.18.0.1
Radio/EM1/EM2
Subnet Mask 255.255.255.192
IP Address 192.168.0.10
Not
No.01 | Root NE Selectable PNMS (V11) Subnet Mask 255.255.255.0
Speed 19200
. Default Gateway 192.168.0.1
Routing
Static Routing Table -
. IP Address 172.18.0.2
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.02 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
. IP Address 172.18.0.3
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.03 | Normal NE
selectable , Default Gateway 172.18.0.1
Routing
Static Routing Table -
_ IP Address 172.18.0.4
Radio/EM1/EM2
Not Subnet Mask 255.255.255.192
No.04 | Normal NE
selectable ) Default Gateway 172.18.0.1
Routing
Static Routing Table -
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6. Using AutoDiscovery on NEO HP & PASO+ Mixed Network.

ROI-S07052

Note: Use only program files that correspond to one of the following versions (or
newer).

PASO+ Series:
(a) STM-1: version 1.6.2 or later
(b) PDH: version 1.2.2 or later

(c) Mx: version 1.2.4 or later

NEO HP: version 2.0.0 or later

® \With NEO HP & PASO+ Mixed Network, activate LLDP function of NEO HP that
is directly connected to PASO+.

® FEther EM1 or EM2 of boundary equipment with NEO HP/PASO+ can be set.
NEO HP and PASO+ are connected with each other through LAN.

192.168.0.10
255.255.255.0
\

172.18.0.1

255.255.255.192

192.168.0.1
255.255.255.0

Normal NE

172.18.0.2
255.255.255.192

PN

1

No.02 F { No.03

[NEO HP]

Normal NE

172.18.0.3

[PASO+]

255.255.255.192

(EM1)

172.18.0.4

PNMT<§

General (Category)
NE TYPE Categor Item Name Input data
CTRL Type Branch NE gory p
Type
IP Address 172.18.0.1
Radio/EM1/EM2 | Subnet Mask 255.255.255.192
LLDP NE Port(EM2) D!sable
NEO N NMS Port(EM1) Disable
N0.01 Root NE ot ad
HP selectable IP Address 192.168.0.10
PNMS (V11) Subnet Mask 255.255.255.0
Speed 19200
. Default Gateway 192.168.0.1
Routing - -
Static Routing Table -
IP Address 172.18.0.2
Radio/EML/EM2 Subnet M;sEkP — 2D$5.i;55.255.192
No.02 | NEO | Normaine | NOt LLDP Or(EM2) ISable
HP selectable NMS Port(EM1) | Enable
. Default Gateway 172.18.0.1
Routing - -
Static Routing Table -
Radio/EM1/EM2 E sddriﬂss K 325'250'2355 192
N0.03 | PASO+ | NormalNE | NO ubnet Mas £99:£99.
selectable Routin Default Gateway 172.18.0.1
g Static Routing Table -
Not Radio/EM1/EM2 IP Address 172.18.0.4
No0.04 | PASO+ | Normal NE selectable Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
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